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1 – 8 Introduction

 

Welcome!

 

Thank you for choosing Steinberg´s Nuendo! Nuendo has been around 
a mere three years – and already it is being used in studios all over the 
world. Audio engineers and editors, producers and artists from the fields 
of film, television, radio, multimedia and music are choosing Nuendo to-
day as their preferred tool for recording, editing and mixing. 

With Nuendo 2.0, the Steinberg programming team has again man-
aged to implement a large set of new features that offer even more 
possibilities than ever before. Support for even more new file formats, 
a completely redesigned mixer with all channels and busses with up to 
12 channels, the time-saving Inspector in the Project Window giving 
instant access to all track parameters and a batch processing function 
– to name just a few. Nuendo 2 also includes the possibility for net-
work collaboration, allowing multiple users on various Nuendo stations 
to work on the same project in parallel, each committing their work to 
the group via TCP/IP and receiving updates from others if desired. 
MIDI functionality has been drastically extended in Nuendo 2. Not only 
have new editors found their way into the program but also new MIDI 
processing functionalities, MIDI plug-ins and the MIDI Device Manager 
are included. And as you will discover there is more – a lot more; all in 
all, no less than 200 new features have been implemented for this new 
version of the Nuendo Media Production System. 

Despite the massive set of features that Nuendo now offers, we still 
managed to guarantee a quick workflow and intuitive handling. You can 
now fully customize Nuendo. You might have seen this on other com-
puter workstations but nowhere ever to the extent that Nuendo offers 
now. First of all, the complete menu structure of Nuendo 2 can be con-
figured to your liking. This means that if you know you are never going to 
use certain functionality, you can easily remove it from all menus. Or you 
can configure Nuendo differently depending on your project. If you do 
not require the extensive new MIDI sound and editing features for a cer-
tain project, you simply remove this entire section from all menus. And 
isn’t it good to know it is still there waiting for you in the background in 
case you need it later? Nuendo also displays only what you need on the 
Transport panel, the toolbar and the tracks in the project. Almost every 
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button or display can be hidden or moved to a less central spot to cre-
ate an interface which is just as complex as you want it to be. This way 
Nuendo 2 gives you everything you need for your work. No more and of 
course no less.

The Nuendo team is very grateful for the input we have received from 
Nuendo users in the past. In fact most of the new features implemented 
were user requests from the worldwide Nuendo community. Due to this 
direct communication and because of the encouraging feedback from 
the people actually using Nuendo in their professional working lives we 
at Steinberg have committed ourselves to continue with the current 
concept of the Nuendo Media Production System:

No matter whether you are working for film, television, radio broadcast 
or if you are involved in music, game sound, multimedia or innovative 
surround production, Nuendo will continue to deliver the right tool for 
any kind of audio production.

Please continue to visit www.nuendo.com and give us your feedback 
and suggestions.

See you there!

Your Steinberg Nuendo team.
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About the manuals and the Help

 

The Nuendo documentation is divided into several sections:

 

Printed books

 

Getting Started

 

This is the book you are reading now. The Getting Started book covers 
the following areas:

 

• Computer requirements.
• Installation issues.
• Setting up your system for audio, MIDI and/or video work.
• A guided tour of the main Nuendo windows.
• Tutorials describing the most common procedures for recording, playing 

back, mixing and editing in Nuendo.
• Basic concepts and terminology.
• A description of the general methods used when working in Nuendo.

 

In other words, this book does not go into detail on any Nuendo win-
dows, functions or procedures.

 

The Operation Manual

 

The Operation Manual is the main Nuendo reference documentation, 
with detailed descriptions of Nuendo operations, parameters, functions 
and techniques. You should be familiar with the concepts and methods 
described in the Getting Started book before moving on to the Opera-
tion Manual.

 

❐

 

Both the Getting Started book and the Operation Manual are available as 

 

Acrobat pdf documents as well – see below.
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Acrobat pdf documents

 

Parts of the documentation are included as documents in the Adobe 
Acrobat format (extension “.pdf”), accessed in the following ways:

 

• You can open the pdf documents from the Help menu in the program.
• Under Windows you can also open these documents from the Nuendo Docu-

mentation subfolder on the Windows Start menu.
• Under Mac OS X the pdf documents are located in the folder /Library/Docu-

mentation/Nuendo/.

 

• To read the pdf documents you need to have the Acrobat Reader appli-
cation installed on your computer.

 

An Acrobat installer is provided on the program CD.

 

The following documents are included in pdf format:

 

Getting Started

 

This is the same document as the Getting Started book with cross ref-
erences and index entries as clickable hyperlinks.

 

Operation Manual

 

This is the same document as the printed Operation Manual with 
cross references and index entries as clickable hyperlinks.

 

MIDI Devices and Features

 

Contains descriptions of the included MIDI effect plug-ins, how to 
manage MIDI devices, how to work with MIDI System Exclusive mes-
sages and how to use the Logical Editor.

 

Audio Effects and VST Instruments

 

Describes the features and parameters of the included VST plug-ins 
(real-time audio effects and VST instruments).

 

Networking

 

This pdf document describes how you can use Nuendo’s project shar-
ing and networking features to collaborate with other users of Nuendo 
(version 2.0 or later) in a TCP/IP based peer-to-peer network.
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Remote Control Devices

 

This pdf document lists the supported MIDI remote control devices 
and describes how to set up and use them with Nuendo.

 

Score Layout and Printing

 

Describes the score editing features in Nuendo.

 

Using Nuendo with DSP Factory (Windows only)

 

Describes how to set up and use a Yamaha DSP Factory audio card 
with Nuendo.
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The Help System

 

Nuendo comes with a detailed help system, making it easy to look up 
procedures and descriptions from within the program. The contents of 
the help basically mirror the complete Operation Manual text. The help 
systems are slightly different depending on which operating system 
you use, Windows or Mac OS X:

 

HTML Help (Windows)

 

You use the HTML Help in the following way:

 

• To open the HTML Help for browsing, select “HTML Help” from the Help 
menu in the program.

 

This brings up the HTML Help browser in which you can browse the help table of con-
tents, search the index or perform a free text search.

 

• To get information about the active window or a dialog, press [F1] on the 
computer keyboard or click the Help button in the actual dialog.

 

Within a topic, related topics are sometimes directly accessible via clickable links.

 

Apple Help (Mac OS X)

 

You use the Apple Help in the following way:

 

• To open the Apple Help for browsing, select “Nuendo Help” from the Help 
menu in the program.

 

This brings up the Apple Help Viewer window. There, you can either browse the help 
table of contents, use the index or type any words into the Search field at the top of the 
window.

 

• To get information about the active window or a dialog, press [F1] on the 
computer keyboard or click the Help button in the actual dialog.

 

Within a topic, related topics are sometimes directly accessible via clickable links.

 

Please note that you can open the Nuendo Help even when the pro-
gram isn’t running: 

 

1.

 

Select “Mac Help” from the Help menu in the Finder.

 

2.

 

In the Apple Help Viewer, bring up the “Help Center”.

 

3.

 

Click the “Nuendo Help” link in the Help Center.
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About the program versions

 

The documentation covers two different operating systems or “plat-
forms”; Windows and Mac OS X. 

Some features and settings are specific to one of the platforms, Win-
dows or Mac OS X. This is clearly stated in the applicable cases. 
In other words:

 

• If nothing else is said, all descriptions and procedures in the documenta-
tion are valid both under Windows and Mac OS X.

 

The screenshots are taken from the Windows version.

 

Key command conventions

 

Many of the default key commands in Nuendo use modifier keys, 
some of which are different depending on the operating system. For 
example, the default key command for Undo is [Ctrl]-[Z] under Win-
dows and [Command]-[Z] under Mac OS X.

When key commands with modifier keys are described in this manual, 
they are shown with the Windows modifier key first, in the following 
form:

 

[Win modifier key]/[Mac modifier key]-[key]

 

For example, 

 

[Ctrl]/[Command]-[Z]

 

 means “press [Ctrl] under Win-
dows or [Command] under Mac OS X, then press [Z]”. 

Similarly, 

 

[Alt]/[Option]-[X]

 

 means “press [Alt] under Windows or 
[Option] under Mac OS X, then press [X]”.
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How you can reach us

 

On the Help menu in Nuendo, you will find items for getting additional 
information and help:

 

•

 

On the “Steinberg on the Web” submenu you can find links to various 
Steinberg websites. Selecting one will automatically launch your 
browser application and open the page.

 

You can find support and compatibility information, answers to frequently asked ques-
tions, links for downloading new drivers, etc. This requires that you have a web 
browser application installed on your computer, and a working Internet connection.
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About this chapter

 

This chapter describes the system requirements and installation pro-
cedures for Nuendo for Windows. Installing Nuendo for Mac OS X is 
described on page 30.

 

Requirements

 

To use Nuendo, you need the following:

 

•

 

A PC with either Windows XP or Windows 2000 installed.

 

A USB Port is also required.

 

For more details about the computer requirements, see below.

 

•

 

Compatible audio hardware.

 

By audio hardware we mean a card capable of recording and playing back digital audio 
using your hard disk as a storage medium. It must also have an appropriate ASIO 
driver, see page 20, or be Windows Multimedia compatible. Also, to take full advantage 
of Nuendo’s multi-channel i/o bus architecture and surround features, you need audio 
hardware with multiple inputs and outputs.

 

For MIDI

 

•

 

At least one MIDI interface.

 

•

 

At least one MIDI instrument.

 

•

 

Any audio equipment necessary to listen to the sound from your MIDI 
devices.
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Computer requirements 

 

Hardware – PC

 

The absolute minimum requirements for running Nuendo on a PC are 
as follows:

 

• A 650 MHz Pentium processor or Athlon processor.
• 256 MB of RAM.
• Monitor and video hardware supporting 1024 x 768 resolution.

 

For optimum performance we recommend the following:

 

• Pentium or Athlon processor at 1.4 GHz or faster
• 512 MB of RAM.
• 1152 x 864 screen resolution or higher.

 

RAM

 

Audio work requires a lot of RAM! In fact, there is a direct relation be-
tween the amount of available RAM and the number of audio channels 
that you can have running. As specified earlier, 256 MB is the minimum 
requirement, but as a general rule “the more the better” applies.

 

Hard disk size

 

•

 

The size of the hard disk determines how many minutes of audio you 
will be able to record. 

 

Recording one minute of stereo CD quality audio, requires 10 MB of hard disk space. 
That is, eight stereo tracks in Nuendo use up at least 80 MB of disk space per record-
ing minute.

 

Hard disk speed

 

The speed of the hard drive also determines the number of audio tracks 
you can run. That is the quantity of information that the disk can read, 
usually expressed as “sustained transfer rate”. Again, “the more the 
better” applies.

 

Wheel mouse

 

Although a regular mouse will work fine with Nuendo, we recommend 
that you use a wheel mouse, as this will speed up value editing and 
scrolling considerably. See page 204 and page 209.
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Audio hardware

 

Nuendo will run with audio hardware that meets the following basic 
specifications:

 

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with a special ASIO driver, or a DirectX or Windows Multimedia 

compatible driver as described below.

 

About drivers

 

A driver is a piece of software that allows a program to communicate 
with a certain piece of hardware. In this case, the driver allows Nuendo 
to use the audio hardware. For audio hardware, there are three different 
cases, each requiring different driver configurations:

 

If the audio hardware has a specific ASIO driver

 

Professional audio cards often come with an ASIO driver written es-
pecially for the card. This allows for communication directly between 
Nuendo and the audio card. As a result, audio cards with specific 
ASIO drivers can provide lower latency (input-output delay), which is 
crucial when monitoring audio via Nuendo or using VST Instruments. 
The ASIO driver may also provide special support for multiple inputs 
and outputs, routing, synchronization, etc.

Audio card-specific ASIO drivers are provided by the card manufac-
turers. Make sure to check the manufacturer’s web site for the latest 
driver versions.

 

❐

 

If your audio hardware comes with a specific ASIO driver we strongly 

 

recommend that you use this.
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If the audio card communicates via DirectX

 

DirectX is a Microsoft “package” for handling various types of Multi-
media under Windows. Nuendo supports DirectX, or to be more pre-
cise, DirectSound, which is a part of DirectX used for playing back 
and recording audio. This requires two types of drivers:

 

• A DirectX driver for the audio card, allowing it to communicate with DirectX. If 
the audio card supports DirectX, this driver should be supplied by the audio 
card manufacturer. If it isn’t installed with the audio card, please check the 
manufacturer’s web site for more information.

• The ASIO DirectX Full Duplex driver, allowing Nuendo to communicate with 
DirectX. This driver is included with Nuendo, and does not require any special 
installation.

 

If the audio card communicates via Windows Multimedia system

 

If the card is Windows compatible, it can be used in Nuendo. The card 
then communicates with Windows Multimedia system, which in turn 
communicates with Nuendo. This requires two types of drivers: 

 

• A Windows Multimedia driver for the audio card, allowing it to communicate 
with the Windows Multimedia system. This driver should be supplied by the 
audio card manufacturer, and is normally installed when you install the audio 
card.

• The ASIO Multimedia driver, allowing Nuendo to communicate with the Win-
dows Multimedia system. This driver is included with Nuendo, and does not 
require any special installation.
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Hardware installation

Installing the copy protection key – please read!

Included with the Nuendo package, you will find a hardware key (some-
times referred to as a “dongle”) that is part of the Nuendo copy protec-
tion scheme. Nuendo will not run if this key isn’t installed properly.

• The copy protection key should be plugged into the computer’s USB 
port after installing Nuendo and restarting the computer!
When the copy protection key is plugged into the USB port, Windows will automati-
cally register it as a new hardware device and will attempt to find drivers for it – these 
necessary drivers won’t be there until Nuendo has been installed and the computer re-
started.

Installing the audio hardware and its driver

1. Install the audio card and related equipment in the computer, as de-
scribed in the card’s documentation.

2. Install the driver for the card.
There are three types of drivers that could apply: card-specific ASIO drivers, DirectX 
drivers and Windows Multimedia drivers:

Specific ASIO driver

If your audio card has a specific ASIO driver it may be included with 
the audio card, but you should always make sure to check the audio 
card manufacturer’s web site for the most recent drivers. For details 
on how to install the driver, refer to the manufacturer’s instructions.

DirectX driver

If your audio card is DirectX compatible, its DirectX drivers will most 
likely be installed when you install the card (as with the Windows Multi-
media driver). If you have downloaded special DirectX drivers for the au-
dio card, you should follow the manufacturer’s installation instructions.
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Windows Multimedia driver

These drivers are normally included with all types of regular PC audio 
cards. Some are even included with Windows itself. Depending on 
whether the audio card is “Plug’n’Play compatible” or not, the installa-
tion of the card is done differently:

• If the card is “Plug’n’Play compatible”, Windows will detect the 
card once it is plugged in, and ask for the necessary driver disks.

• If not, you need to use the “Add New Hardware” feature in the Control 
Panel to install the card and its drivers.
Refer to the documentation that comes with the card.

❐ Should you have an audio card but no driver, please check the manufac-
turer’s web site, or ask your music or computer dealer for help.

Testing the card

To make sure the audio card will work as expected, perform the fol-
lowing two tests:

• Use any software included with the audio card to make sure you can 
record and play back audio without problems.

• If the card is accessed via a standard Windows driver, use the Media 
Player application (included with Windows) to play back audio.
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Installing a MIDI interface/synthesizer card

Installation instructions for a MIDI interface should be included with 
the product. However, here’s an outline of the necessary steps:

1. Install the interface (or MIDI synthesizer card) inside your computer or 
connect it to a “port” (connector) on the computer.
Which is right for you depends on which type of interface you have.

2. If the interface has a power supply and/or a power switch, turn it on.

3. Install the driver for the interface, as described in the documentation 
that comes with the interface.
It is likely that you will need a CD ROM or floppy disk supplied by the manufacturer of 
the MIDI interface. You should also make sure to check the manufacturer’s web site for 
the latest driver updates.
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Installing Nuendo

Defragment the hard disk

If you plan to record audio on a hard disk where you have already 
stored other files, now is the time to defragment it. Defragmentation 
reorganizes the physical allocation of space on the hard disk in order 
to optimize its performance. It is done with a special defragmentation 
program. In Windows XP, for example, you might look for the “Disk 
Defragmenter” utility.

❐ It is crucial to the audio recording performance that your hard disk is op-
timized (defragmented). You should make sure to defragment regularly.

Installing the files from the CD-ROM

The installation procedure puts all files in the right places, automatically.

1. Insert the Nuendo CD-ROM.

2. A pop-up dialog appears automatically, containing three items for in-
stalling, browsing the CD and exiting.
If this dialog doesn’t appear, open the CD-ROM on the desktop, and double click the 
“Autorun.EXE”.

3. To start the installation process, select “Install”.
Now the Nuendo installation procedure starts. A number of dialogs will appear, allow-
ing you to select in which folder on your hard disk you want to install the program, etc. 
To advance to the next “page” in the installation procedure, click the “Next” button. The 
“Previous” button takes you back to the previous page.

• In one dialog you will need to fill in your name and the serial number of 
your Nuendo copy, and click OK.
You will find the serial number on the registration card that comes with the Nuendo 
package. Check the name and number in the confirmation dialog and click “Yes” if they 
are correct. Clicking “No” brings back the previous dialog.

• You will be asked to read and confirm the licence agreement (shown 
on screen).
This is required for the installation to proceed.
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• At one point you will be asked whether Nuendo should be available to 
all users of the computer or just to you.
Choose the option that suits you best.

• You will also be asked whether you want to install audio effect plug-
ins from earlier Nuendo versions.
This is primarily intended to ensure compatibility with songs created with earlier versions, 
but will of course also give you a wider palette of plug-ins to choose from. You can either 
just select to install or to ignore all previous plug-ins and instruments (by activating/deac-
tivating the checkbox), or click the Details button to select from a list where you can de-
cide which plug-ins to install. 

4. Finally, a dialog box informs you that the installation was successful 
and recommends that you restart your computer.

5. After restarting the computer, plug in the hardware protection key into 
the USB port.
If you are unsure over which port this is, consult the computer’s documentation.

6. The first time the copy protection device is plugged in, it will be regis-
tered as a new hardware device, and a dialog will appear asking you 
whether you would like to find drivers for the device manually or auto-
matically. You should select to find drivers automatically.
The dialog closes.

7. You are now ready to launch Nuendo!
Remove the CD-ROM and store it in a safe place.

This completes the installation of your Nuendo program! 

❐ For information about product updates, you should check the Steinberg 
website regularly. Open the “Steinberg on the Web” submenu on the 
Help menu and select “Product Updates”. The website that opens con-
tains a list with the recent updates.
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The items on the start menu

If you open the Windows Start menu, you will find a Nuendo group on 
the “Programs” submenu. This contains the following items:

• Documentation.
On this submenu you can access the various Nuendo documentation files in the Acro-
bat pdf format. These documents are also available on the Help menu from within the 
program.

• ASIO DirectX Full Duplex Setup.
This is where you make settings if your audio hardware uses DirectX for audio play-
back and recording.

• ASIO Multimedia Setup.
This opens a dialog with settings for the ASIO (Audio Stream Input Output) system, 
which handles audio recording and playback in Nuendo, if you are using the ASIO 
MME driver. This dialog can also be opened from within Nuendo. See the chapter 
“Setting up your system” in this book.

• Nuendo.
This launches the actual program. 

On the “Programs” submenu you will also find an item called Syncrosoft 
(License Control Center). This item shows all Syncrosoft protection de-
vices and valid licences currently installed.

There may also be additional items (such as Readme files) available on 
the Start menu. Please read all such files before launching Nuendo, 
since they may contain late information not included in the manuals.
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About this chapter

This chapter describes the system requirements and installation pro-
cedures for Nuendo for Mac OS X. Installing Nuendo for Windows is 
described on page 18.

Requirements

To use Nuendo, you need the following:

• A Macintosh computer running Mac OS X.
A USB Port is also required.

For more details about the computer requirements, see below.

• Mac OS X compatible audio hardware.
While the built-in audio hardware of the Macintosh may be adequate for basic audio 
playback, we strongly recommend audio hardware that is specifically designed for audio 
recording and music applications. Also, to take full advantage of Nuendo’s multi-channel 
i/o bus architecture and surround features, audio hardware with multiple inputs and out-
puts is required.

For MIDI

• At least one MIDI interface.

• At least one MIDI instrument.

• Any audio equipment necessary to listen to the sound from your MIDI 
devices.
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Computer requirements 

Hardware – Mac

The absolute minimum requirements for running Nuendo on a Macin-
tosh are as follows:

• Macintosh with a G4 processor, 256 MB RAM and OS X.
We recommend a G4 733 MHz or faster, 512 MB RAM or more and OS X 10.2.

RAM

Audio work requires a lot of RAM! In fact, there is a direct relation be-
tween the amount of available RAM and the number of audio channels 
that you can have running. As specified earlier, 256 MB is the minimum 
requirement, but as a general rule “the more the better” applies.

Hard disk size

• The size of the hard disk determines how many minutes of audio you 
will be able to record. 
Recording one minute of stereo CD quality audio, requires 10 MB of hard disk space. 
That is, eight stereo tracks in Nuendo use up at least 80 MB of disk space per record-
ing minute.

Hard disk speed

The speed of the hard drive also determines the number of audio 
tracks you can run. That is the quantity of information that the disk can 
read, usually expressed as “sustained transfer rate”. Again, “the more 
the better” applies.

Mouse

Although a regular mouse will work fine with Nuendo, we recommend 
that you use a wheel mouse with two mouse buttons.

• Having a wheel mouse will speed up value editing and scrolling considerably.
• If your mouse has two mouse buttons you should program the right mouse 

button to generate a [Ctrl]-click (this is typically the default behaviour of the 
right mouse button). 
This will allow you to bring up context menus by right clicking (see page 201).
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Audio hardware

Nuendo will run with audio hardware that meets the following basic 
specifications:

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with proper Mac OS X (Core Audio) drivers.

A basic rule of thumb is: if the hardware works under Mac OS X, you 
can use it in Nuendo.

• Nuendo also supports audio hardware with Mac OS X compliant ASIO 
drivers.
ASIO drivers may provide special support for routing, monitoring, synchronization, etc. 
Note that the ASIO drivers must be written specifically for Mac OS X – Mac 9.X ASIO 
drivers cannot be used.

Using the built-in audio hardware of the Macintosh

Although Nuendo is designed with multi-channel input and output in 
mind, it’s of course possible to use the program with “basic” stereo in-
puts and outputs. As of this writing, all current Macintosh models have 
built-in 16 bit stereo audio hardware. Depending on your preferences 
and requirements, this may be sufficient for use with Nuendo. The 
built-in audio hardware is always available for selection in Nuendo – 
you don’t need to install any additional drivers.

❐ Some Macintosh models have audio outputs but no inputs. This means 
that you can only play back audio – recording is not possible without ad-
ditional audio hardware.
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Hardware installation

About the copy protection key – please read!

Included with the Nuendo package, you will find a hardware key (some-
times referred to as a “dongle”) that is part of the Nuendo copy protec-
tion scheme. Nuendo will not run if this key isn’t installed properly.

• You should first install the program (and any necessary hardware, see 
below), then insert the copy protection key and finally launch the 
program.
This is because the necessary drivers for the key are installed when you install the 
program.

Installing the audio hardware and its driver

1. Make sure you have the latest Mac OS X drivers for the audio hardware!
Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the audio hardware.
This is usually done by running an installer application.

3. Install or connect the audio interface, as described in the card’s 
documentation.

Installing a MIDI interface

1. Make sure you have the latest Mac OS X drivers for the MIDI interface!
Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the interface.
This is usually done by running an installer application.

3. Connect the MIDI interface to the computer, as described in the inter-
face documentation.
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Installing Nuendo

Defragment the hard disk

If you plan to record audio on a hard disk where you have already 
stored other files, now is the time to defragment it. Defragmentation 
reorganizes the physical allocation of space on the hard disk in order 
to optimize its performance. It is done with a special defragmentation 
program.

❐ It is crucial to the audio recording performance that your hard disk is op-
timized (defragmented). You should make sure to defragment regularly.

Installing the files from the CD-ROM

The installation procedure puts all files in the right places, automatically.

1. Insert the Nuendo CD-ROM.

2. Open and read the file “Read Me First” before continuing.
This may contain late breaking news pertinent to the installation.

3. Locate the Nuendo installer and run it.
The installation procedure starts. This will create a Nuendo folder in your Applications 
folder and add various required files to your system.

• At one point during the installation you will need to fill in your name 
and the serial number of your Nuendo copy.
You will find the serial number on the registration card that comes with the Nuendo 
package.

• You will be asked to read and confirm the licence agreement (shown 
on screen).
This is required for the installation to proceed.

• You will also be asked whether you want to install plug-ins and instru-
ments from earlier Nuendo versions.
This is primarily intended to ensure compatibility with songs created with earlier versions, 
but will of course also give you a wider palette of plug-ins to choose from.

Finally, a dialog box informs you that the installation was successful.



NUENDO
Installation and Requirements for Mac OS X 3 – 35

4. Plug in the hardware protection key into a free USB port.
If you are unsure over which port this is, consult the computers documentation.

5. You are now ready to launch Nuendo!
Remove the CD-ROM and store it in a safe place.

This completes the installation of your Nuendo program!

❐ For information about product updates, you should check the Steinberg 
website regularly. Open the “Steinberg on the Web” submenu on the Help 
menu and select “Product Updates”. The website that opens contains a 
list with the recent updates.
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Setting up audio

❐ Always make all connections with all equipment turned off!

Connecting audio

Exactly how to set up your system is a very personal matter, the follow-
ing connection diagrams should be taken as examples.

The audio connections below may be digital or analog, it doesn’t matter.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Nuendo, you might con-
nect your audio hardware directly to the input source, a mixer for ex-
ample, and the outputs to a power amplifier and speaker.

A simple stereo audio setup.

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

L R
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Multi-channel input and output

Most likely however, you will have other audio equipment that you 
want to integrate with Nuendo. This will require a mixer, preferably one 
with a group or bus system that can be used for feeding inputs on the 
audio hardware.

In the example below, four buses are used for feeding signals to the 
sound hardware’s inputs. The four outputs are connected back to the 
mixer for monitoring and playback. Remaining mixer inputs can be used 
for connecting audio sources like microphones, instruments, etc.

A multi-channel audio setup.

• When connecting an input source (like a mixer) to the audio hardware, 
you should use output buses, sends or similar that are separate from the 
mixer’s master output to avoid recording what you are playing back.

Audio    card inputs

Audio card outputs

Amplifier and speakersMixer

Inputs
1 to 4

Bus
1 to 4 L R
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Connecting for surround sound

If you plan to mix for surround sound, you could connect the audio 
outputs to a multi-channel power amplifier, driving a set of surround 
channels.

A surround sound playback configuration.

Nuendo supports a number of surround formats. The example connec-
tion above will work for mixing both LRCS (ProLogic for example) and 
5.1, in which case the two surround speakers will be playing the same 
material (from the single surround channel). The difference between 
the two formats is the LFE channel, which is not used with LRCS.

Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as 
a regular CD player. In some cases the CD player is internally con-
nected to the audio hardware so that you can record the output of the 
CD player directly into Nuendo (consult the audio hardware docu-
mentation if you are uncertain).

• All routing and level adjustments for recording from a CD (if available) are 
done in the audio hardware setup application (see page 42).

• You can also grab audio tracks directly from a CD in Nuendo (see the Opera-
tion Manual). 

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

RCL

Rs/S

LFE

Ls/S
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Word Clock connections

If you are using a digital audio connection you may also need a word 
clock connection between the audio hardware and external devices. 
Please refer to the documentation that came with the audio hardware 
for details.

❐ It is very important that word clock synchronization is done correctly or 
there might be clicks and crackles in recordings that you make!

About recording levels and inputs

When you connect your equipment, you should make sure that the im-
pedance and levels of the audio sources and inputs are matched. 
Typically, different inputs may be designed for use with microphones, 
consumer line level (-10 dBV) or professional line level (+4 dBV), or 
you may be able to adjust input characteristics on the audio interface 
or in its control panel. Please check the audio hardware documenta-
tion for details.

Using the correct types of input is important to avoid distortion or 
noisy recordings. For more information about checking input levels, 
see page 78.

❐ Nuendo does not provide any input level adjustments for the signals 
coming in to your audio hardware, since these are done differently for 
each card. Adjusting input levels is either done in a special application in-
cluded with the hardware or possibly from its control panel (see below). 
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Making settings for the audio hardware

Most audio cards come with one or more small applications that allow 
you to configure the inputs of the hardware to your liking. 
This includes:

• Selecting which inputs/outputs are active.
• Setting up word clock synchronization (if available).
• Turning monitoring via the hardware on/off (see page 48).
• Setting levels for each input. This is very important!
• Setting levels for the outputs, so that they match the equipment you use for 

monitoring.
• Selecting digital input and output formats.
• Making settings for the audio buffers.

In many cases all available settings for the audio hardware are gath-
ered in a control panel, which can be opened from within Nuendo as 
described below (or opened separately, when Nuendo isn’t running). 
In some cases there may be several different applications and panels – 
please refer to the audio hardware documentation for details.
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Selecting a driver and making audio settings in Nuendo

The first thing you need to do is select the correct driver in Nuendo to 
make sure that the program can communicate with the audio hard-
ware:

1. Launch Nuendo, select Device Setup from the Devices menu and click 
on VST Multitrack in the list.
Make sure the “Setup” tab is selected.

The VST Multitrack panel in the Device Setup dialog.

2. Select your audio hardware from the ASIO Driver menu.
There may be several options here that all refer to the same audio hardware:

❐ Under Windows we strongly recommend that you access your hardware 
via an ASIO driver written specifically for the hardware, if available. If no 
ASIO driver is installed we recommend that you check with your audio 
hardware manufacturer if they have an ASIO driver available, for exam-
ple for download via the Internet.

3. Bring up the control panel for the audio hardware and adjust the set-
tings as recommended by the audio hardware manufacturer.
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• Under Windows, you can open the control panel by clicking the Con-
trol Panel button in the VST Multitrack panel.
The control panel that appears when you click this button is provided by the audio 
hardware manufacturer and not Nuendo (unless you use DirectX or MME, see below). 
Hence it will be different for each audio card brand and model.
The Control panels for the ASIO Multimedia and ASIO DirectX drivers are an excep-
tion, as they are provided by Steinberg. They are described in the HTML Help, opened 
by clicking the Help button in the respective dialog. See also the notes below.

• Under Mac OS X, you will find the control panel for your audio hard-
ware in the System Preferences (“Other” section), opened from the 
Apple menu or from the Dock.
If you are using the built-in audio hardware of the Macintosh, you use the “Sound” con-
trol panel in the System Preferences to set levels, balance, etc.
If you are using ASIO audio hardware, you can click the Control Panel button to bring 
up its panel.

4. If you plan to use several audio applications simultaneously, you may 
want to activate the option “Release ASIO Driver in Background”. 
This will allow another application to play back via your audio hard-
ware even though Nuendo is running.
The application that is currently active (i.e. the “top window” on the desktop), will get 
access to the audio hardware. Make sure that any other audio application accessing 
the audio hardware is also set to release the ASIO (or Mac OS X) driver so Nuendo 
can use it when becoming the active application again.

5. If your audio hardware and its driver support ASIO Direct Monitoring, 
you may want to activate the Direct Monitoring checkbox.
Read more about monitoring later in this chapter and in the Recording chapter in the 
Operation Manual.

6. Click Apply and then OK to close the dialog.
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If you are using audio hardware with a DirectX driver (Windows only)

❐ If your Windows audio hardware doesn’t have a specific ASIO driver, a 
DirectX driver is the next best option.

There are two ASIO DirectX drivers available with Nuendo: 

• ASIO DirectX.
This driver allows audio output only, not audio input (in other words, playback only, not 
recording). It is therefore not a suitable choice if you want to record audio in Nuendo 
(but it can be used for mixing and playback).

• ASIO DirectX Full Duplex.
This driver allows both audio recording and playback. However:

• To be able to take full advantage of DirectX Full Duplex, the audio hard-
ware must support WDM (Windows Driver Model) in combination with 
DirectX version 8.1 or higher. 
In all other cases, the audio inputs will be emulated by DirectX (see the HTML Help for 
the ASIO DirectX Full Duplex Setup dialog for details about how this is reported). 
Since using emulated inputs will result in higher latency, you may want to use the ASIO 
Multimedia driver instead, as this gives you more possibilities to fine-tune the settings.

• In most cases, DirectX will already be installed on your computer. 
If not (or if your DirectX version is older than 8.1) you find a DirectX 8.1 installer on the 
Nuendo program CD.

When the ASIO DirectX Full Duplex driver is selected in the Device 
Setup dialog, you can open the ASIO Control Panel and adjust the 
following settings (for more details, click the Help button in the control 
panel):

• Direct Sound Output and Input Ports
In the list to the left in the window, all available Direct Sound Output and Input Ports 
are listed. In many cases, there will only be one Port in each list. To activate or deacti-
vate a Port in the list, click the checkbox in the left column.If the checkbox is ticked, the 
port is activated.

• You can edit the Buffer Size and Offset settings in this list if necessary, by 
double clicking on the value and typing in a new value. 
In most cases the default settings will work fine. Audio buffers are used when audio 
data is transferred between Nuendo and the audio card. While larger buffers ensure 
that playback will occur without glitches, the latency (the time between the moment 
Nuendo sends out the data and when it actually reaches the output) will be higher.
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• Offset
If a constant offset is audible during playback of Audio and MIDI recordings, you can 
adjust the output or input latency time using this value.

If you are using audio hardware with a Windows Multimedia (MME) driver

When you select the ASIO Multimedia Driver for the first time, the sys-
tem will ask you whether you want to test the configuration. We strongly 
recommend that you perform this test. If it fails, or if you for other rea-
sons need to make adjustments to your ASIO Multimedia configuration, 
click the Control Panel button to open the ASIO Multimedia Setup con-
trol panel included with Nuendo. This control panel comes with an 
HTML Help describing the features and procedures.

Setting up the input and output ports

Once you have selected the driver and made the settings as de-
scribed above, you need to specify which inputs and outputs should 
be used and name these:

1. In the Device Setup dialog, select VST Outputs in the list to the left.
Make sure the Setup tab is selected.

All output ports on the audio hardware are listed.
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2. To hide an output port, click in the “Visible” column for the port (so 
that it says “No”).
Ports that aren’t visible cannot be selected in the VST Connections window where you 
set up your input and output busses – see page 75. 

❐ If you attempt to hide a port that is already used by a bus you will be 
asked whether this is really what you want – note that this will disable 
the output port!

3. To rename a port, click on its name in the list and type in a new name.

• It is a good idea to give your ports generic names that are related to the 
channel configuration (rather than to the actual hardware model)! 
For example, if you are using a 5.1 surround audio setup, you could name the six ports 
Left, Right, Center, Lfe, Left Surround and Right Surround. This makes it easier to trans-
fer your projects between different computers, e.g. in different studios – if the same port 
names are used on both computers, Nuendo will automatically handle the bus connec-
tions properly when you open the project on the other computer.

4. Select VST Inputs in the list to the left and set up the input ports in the 
same way.

5. Click OK to close the Device Setup dialog and apply your changes.
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About monitoring

In Nuendo, monitoring means listening to the signal being recorded 
while preparing to record or while recording. There are basically three 
ways to monitor:

External monitoring

External monitoring (listening to the input signal before it goes into 
Nuendo) requires an external mixer for mixing the audio playback with 
the input signal. This mixer could be a stand-alone physical mixer or a 
mixer application for your audio hardware, if this has a mode in which 
the input audio is sent back out again (usually called “Thru”, “Direct 
Thru” or similar).

Via Nuendo

In this case, the audio passes from the input into Nuendo, possibly 
through Nuendo effects and EQ and then back to the output. You 
then control monitoring via settings in Nuendo.

This allows you to control the monitoring level from Nuendo and add 
effects to the monitored signal only. 

• To avoid noticeable delay in the monitor signal, you need audio hard-
ware with low latency (see page 55).

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO 
Direct Monitoring (this feature may also be available for audio hard-
ware with Mac OS X drivers). In this mode, the actual monitoring is 
done in the audio hardware, by sending the input signal back out 
again. However, monitoring is controlled from Nuendo. This means 
that the audio hardware’s direct monitoring feature can be turned on 
or off automatically by Nuendo.

Monitoring is described in detail in the Recording chapter in the Oper-
ation Manual. However, when setting up, there’s one thing to note:

• If you want to use the external monitoring via your audio hardware, 
make sure the corresponding functions are activated in the card’s 
mixer application.
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Setting up MIDI

❐ Always make all connections with all equipment turned off!

This section describes how to connect and set up MIDI equipment. If 
you have no MIDI equipment you can skip this section.

Connecting the MIDI equipment

Below follows a description of a typical but small setup example. You 
might need or want to hook things up differently!

In this example we assume that you have a MIDI keyboard and an ex-
ternal MIDI sound module. The keyboard is used both for feeding the 
computer with MIDI messages for recording and for playing back MIDI 
tracks. The sound module is used for playback only. Using Nuendo’s 
MIDI Thru feature (described later) you will be able to hear the correct 
sound from the sound module while playing the keyboard or recording.

A typical MIDI Setup.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru
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You might want to use even more instruments for playback. If you do, 
simply connect MIDI Thru on the sound module to MIDI In on the next 
instrument, and so on. In this hook-up, you will always play the first 
keyboard when recording. But, you can still use all your devices for 
providing sounds on playback.

❐ If you plan to use more than three sound sources we recommend that 
you either use an interface with more than one output, or a separate 
MIDI Thru box instead of the Thru jacks on each unit.

Setting MIDI Thru and Local On/Off

In the “MIDI” section in the Preferences dialog (located on the File menu 
under Windows and on the Nuendo menu under Mac OS X), you will 
find a setting called “MIDI Thru Active” which can be enabled or not. This 
is related to a setting in your instrument called “Local On/Off” or “Local 
Control On/Off”.

• If you use a MIDI keyboard instrument, as described earlier in this chapter, 
MIDI Thru should be activated and that instrument should be set to Local Off 
(sometimes called Local Control Off – see the instrument’s operation manual 
for details). This will let the MIDI signal from the keyboard get recorded into 
Nuendo and at the same time re-routed back to the instrument so that you 
hear what you are playing, without the keyboard “triggering” its own sounds.
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• If you use a separate MIDI keyboard – one that does not produce any sounds 
itself – MIDI Thru in Nuendo should also be activated, but you don’t need to 
look for any Local On/Off setting in your instruments.

• The only case where MIDI Thru should be deactivated is if you use Nuendo with 
only one keyboard instrument and that instrument cannot be set to Local Off 
mode.

• Note that MIDI Thru will only be active for MIDI tracks that are record enabled 
and/or have the monitor button activated. See the Recording chapter in the 
Operation Manual for more information.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru

“Synth” 

When “MIDI Thru” is active in Nuendo, MIDI 
data received is immediately “echoed” back 
out.

When you press a key, it is sent 
out via MIDI to Nuendo.

MIDI data coming in to the instrument 
is played by the “Synth” inside it.

When Local Control is turned on in the instru-
ment, the keys you press will be played by the 
“Synth” inside the Instrument.
When Local Control is turned off, this connection 
is cut off.
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Setting up MIDI ports in Nuendo

The Device Setup dialog lets you set up your MIDI system in the fol-
lowing ways:

• Note: After changing a setting in the Device Setup dialog, you should 
click Apply and then click OK to close the dialog.

Showing or hiding MIDI Ports

Under Windows, the MIDI ports are listed in the Device Setup dialog 
on the DirectMusic page and/or the Windows MIDI page (depending 
on your system). By clicking in the “Show” column for a MIDI input or 
output, you can specify whether or not it should be listed on the MIDI 
pop-up menus in the program.

Under Mac OS X, you can hide or show MIDI ports on the MIDI Sys-
tem page in the Device Setup dialog.

• Hiding a MIDI port from view does not turn it off if it’s already selected for 
a track or a MIDI device.

Setting up the “All MIDI Inputs” option

When you record MIDI in Nuendo, you can specify which MIDI input 
each recording MIDI track should use. However, you can also select 
the “All MIDI Inputs” option, which causes any MIDI data from any 
MIDI input to be recorded.

The All MIDI Inputs page in the Device Setup dialog allows you to spec-
ify which inputs should be included when you select All MIDI Inputs for 
a MIDI track. This can be especially useful if your system provides sev-
eral instances of the same physical MIDI input – by deactivating the du-
plicates you make sure only the desired MIDI data is recorded.

• If you have a MIDI remote control unit connected you should also make 
sure to deactivate that MIDI input on the All MIDI Inputs page.
This is to avoid accidentally recording the data from the remote control when the “All 
MIDI Inputs” option is selected as input for a MIDI track.
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Setting up a default MIDI input and output

The Default MIDI Ports page in the Device Setup dialog allows you to 
select which MIDI ports should be selected by default when you create 
a new MIDI track. In other words, newly created tracks will always use 
the input and output specified on this page. However, you can later 
change this setting for each individual track in the Project window.

Connecting a synchronizer

❐ Always make all connections with all equipment turned off!

When using Nuendo with external tape transports you will most likely 
need to add a synchronizer to your system. All connections and setup 
procedures for synchronization are described in the Synchronization 
chapter in the Operation Manual.
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Setting up video

❐ Always make all connections with all equipment turned off!

Nuendo plays back video films in AVI, Quicktime or MPEG formats. 
Under Windows, video playback can be done using one of three play-
back engines: Video for Windows, DirectShow or Quicktime. This en-
sures compatibility with as wide a range of video files as possible. 
Under Mac OS X, Quicktime is always used as playback engine. 

Generally there are two ways to play back video:

• Without any special hardware at all, using the computer CPU.
In this case, the “codec” is in software. While this will be fine in many situations it does 
put a limit on the size of the video window as well as the quality of the image.

• Using video hardware that for example connects to an external monitor.
Mac OS X: Using a FireWire port, you can play back video on an external monitor using 
a DV-to-analog converter or a DV camera (see also the Video chapter in the Operation 
Manual).
This is valid for DV video and QuickTime is used for playback.

❐ Hardware solutions for playing back a video on an external monitor and 
further information can be found on www.steinberg.net.

If you plan to use special video hardware, install it and set it up as 
recommended by the manufacturer.

Before you use the video hardware with Nuendo, we recommend that 
you test the hardware installation with the utility applications that came 
with the hardware and/or the Windows Media Player or Quicktime 
Player (Mac OS X) applications.
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Optimizing audio performance

This section gives you some hints and tips on how to get the most out 
of your Nuendo system, performance-wise. Some of this text refers to 
hardware properties and can be used as a guide when upgrading your 
system. This text is very brief. Look for details and current information 
on the Nuendo web site (see page 15)!

Two aspects of performance

There are two distinct aspects of performance in respect to Nuendo:

Tracks and effects

Simply put: the faster your computer, the more tracks, effects and EQ 
you will be able to play. Exactly what constitutes a “fast computer” is al-
most a science in itself, but some hints are given below.

Short response times (latency)

Another aspect of performance is response times. Latency is a phenom-
enon based on the fact that in a computer, audio has to be “buffered” 
(stored) in small chunks during various steps of the recording and play-
back process. The more and larger those chunks, the higher the latency.

High latency is most troublesome when playing VST Instruments and 
when monitoring through the computer, that is when listening to a live 
audio source via the Nuendo Mixer and effects. However, very long 
latency times (several hundred milliseconds) can hamper other pro-
cesses like mixing, since e.g. a fader movement will affect the audio 
noticeably late.

While Direct Monitoring and other techniques reduce the problems 
associated with very long latency times, a system that responds fast 
will always be more convenient to work with.

• Depending on your audio hardware, it may be possible to “trim” your 
latency times, usually by lowering the size and number of buffers.
For details, refer to the audio hardware documentation, or, if you are using a DirectX or 
MME driver under Windows, the HTML Help.
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System factors that affect performance

CPU and processor cache

It goes without saying that the faster the computer processor, the bet-
ter. But there are a number of factors that affect the apparent speed of 
a computer: the bus speed and type (PCI is strongly recommended), 
the processor cache size and of course, the processor type and brand.

Nuendo relies heavily on floating point calculations. When shopping 
for a processor, please make sure you get one that is powerful in cal-
culating floating point arithmetics.

Note also that Nuendo features full support for multi-processor systems. 
So if you own a computer system with more than one processor, Nuendo 
can take advantage of the total capacity and evenly distribute the pro-
cessing load to all the available processors. See page 57 for more details.

Hard disk and controller

The number of hard disk tracks you can record and play back at the 
same time also depends on the speed of your hard disk and hard disk 
controller. If you use E-IDE disks and controllers, make sure that the 
transfer mode is DMA Busmaster. Under Windows, you can check the 
current mode by launching the Windows Device Manager and looking 
for properties of the IDE ATA/ATAPI Controller’s primary and second-
ary channel. DMA transfer mode is enabled by default, but may be 
turned off by the system should hardware problems occur.

Audio hardware and driver

The hardware and its driver can have some effect on regular perfor-
mance. A badly written driver can reduce the performance of your com-
puter. But where the hardware driver design makes the most difference 
is with latency.

❐ Again, we strongly recommend that you use audio hardware for which 
there is a specific ASIO driver!

This is especially true when using Nuendo for Windows:

• Under Windows, ASIO drivers written specifically for the hardware are more 
efficient than MME or DirectX and normally produce shorter latency times.
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• Under Mac OS X however, audio hardware with properly written Mac OS X 
(Core Audio) drivers can be very efficient and produce very low latency times.
Still, there are additional features currently only available with ASIO drivers, such as 
the ASIO Positioning Protocol.

Making settings that affect performance

Choosing a driver for your audio hardware

As described on page 43, it is recommended to install and use a stan-
dard ASIO driver if available for your specific hardware. Check the 
manufacturers web site for the latest drivers etc.

Making audio buffer settings

Audio buffers affect how audio is sent to and from the audio hardware. 
The size of the audio buffers affect both the latency and the audio per-
formance. Generally, the smaller the buffer size, the lower the latency. 
On the other hand, working with small buffers can be demanding for 
the computer. If the audio buffers are too small, you may get clicks, 
pops or other audio playback problems.

• Under Mac OS X, you can adjust the size of the buffers on the VST Multitrack 
page in the Device Setup dialog.
You may also find buffer settings in the control panel for the audio hardware.

• Under Windows, you adjust the buffer size settings in the control panel for the 
audio hardware (opened by clicking the Control Panel button on the VST Multi-
track page in the Device Setup dialog).

The Expert settings

In the VST Multitrack panel you will find a button called “Expert…”. 
This opens a dialog with advanced settings for the VST Engine, includ-
ing a Multi Processing switch. When this is activated (default setting if 
you have a hyper-threading or multiple-CPU system – in a single-CPU 
system, this option is greyed out) and there is more than one CPU in 
your system, the processing load is distributed evenly to all available 
CPUs, allowing Nuendo to make full use of the combined power of the 
multiple processors. See the Online Help for details.

Activating the “Lower Latency” option, will basically disable the CPU 
overload protection, but allow for lower latencies. See the Online Help 
for details.
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Optimizing processor scheduling (Windows only)

To get the lowest possible latencies when using ASIO under Windows 
2000 or XP (on a single CPU system), the 'system performance' has to 
be optimized for background tasks:

Windows 2000

1. Open the Control Panel from the Start menu and select System.

2. Select the Advanced tab and click the Performance Options button.

3. In the dialog that appears, select “Optimize performance for: Back-
ground services”.

4. Click OK to close the dialogs.

Windows XP

1. Open the Control Panel from the Start menu and select System.

2. Select the Advanced tab and click the Settings button in the Perfor-
mance section.
The Performance Options dialog appears.

3. Select the Advanced tab.

4. In the Processor Scheduling section, select “Adjust for best perfor-
mance of: Background services”

5. Click OK to close the dialogs.

Related Information (Windows only)

ACPI vs. Standard PC mode

Windows 2000/XP users should consider the important information re-
lating to audio performance as presented on the Steinberg Knowledge 
Base. If you have a working internet connection, select “Steinberg on 
the Web” and then “Knowledge Base” in the Nuendo Help menu. In 
the knowledge base, do a search for “ACPI” and click the article with 
the subject “Optimization of Windows 2000/XP: ACPI kills audio per-
formance”.
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The main windows in Nuendo

The Project window

The Project window is the main window in Nuendo. This provides you 
with a graphic overview of the project, allowing you to navigate and 
perform large scale editing. The Project window is divided vertically 
into tracks and has a time line going from left to right. Each project has 
one Project window.

The Track list with 
various track types.

The project cursor.

The area with various track 
settings to the left is called the 
Inspector.

The area to the right in the Project win-
dow is called the event display. This is 
where you view and edit audio and MIDI 
events, automation curves, etc.
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The Project Browser

The Project Browser provides a list based representation of the project. 
This allows you to view and edit all events on all tracks by using regular 
value editing in a list.

The Transport panel

The Transport panel features transport controls, much like those 
found on a conventional tape recorder. It can also be used for locating 
Marker positions, setting tempo and time signature, etc.

• Note that you can customize the appearance of the Transport panel!
You can remove controls that you don’t need to use or even change the positions of 
the different sections on the panel. This is described in the Customizing chapter in the 
Operation Manual.

Tempo display and 
metronome settingsPosition displays

Transport controlsThe left and right locators 
define where to start and 
end recording and what 
section to cycle.

Jog/shuttle controls

Marker 
section

CPU/Disk meter Audio 
Input/output 
activity meters

Recording 
modes and 
auto quantize Sync display

MIDI
Input/Output 
activity meters
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The Pool

All files, audio or video, that belong to a project are listed in the Pool. 
There is a separate Pool for every project. In the Pool you can orga-
nize, convert and audition clips, amongst many other things.

Audio folder

Trash folder Video folder

Audio clips

Waveform image
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The Sample Editor

In the Sample Editor you can view and manipulate audio, by cutting 
and pasting, removing or drawing audio data. By using the Offline 
Process History, you can undo changes or revert to the original ver-
sions at any point.

Thumbnail overview

Waveform view A selected range
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The MIDI editors

Editing MIDI data is done using the MIDI editors. The following editors 
are available:

Key Editor

The Key Editor shows the contents of one or several MIDI parts. The 
MIDI notes are represented by “boxes”, whose vertical position corre-
sponds to their pitch.

This box represents a MIDI note.

This section is called the controller display. It shows “continuous” MIDI 
events (such as controllers) or as in this figure, the velocity values of notes.
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Score Editor

The Score Editor shows MIDI notes as a musical score and comes 
with advanced tools and functions for notation, layout and printing.

❐ Full Score editing is described in the separate document “Score Layout 
and Printing”. This can be accessed via the Help menu in the program.

List Editor

The List Editor shows all events in a MIDI part as a list, allowing you to 
view and edit their properties numerically.
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Drum Editor

The Drum Editor is similar to the Key Editor, but takes advantage of 
the fact that with drum parts, each key corresponds to a separate 
drum sound.

Tempo Track Editor

For each audio and MIDI track, you can specify whether it should use a 
musical or linear Time base. Tempo based tracks follow a tempo, which 
can either be fixed through the whole project or follow the Tempo Track. 
In the Tempo Track Editor you can draw curves that determine how the 
tempo will change over time.

Time signature events

The tempo curve
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The Mixer

The Mixer is where you mix your audio and MIDI channels, that is, adjust 
the levels (volume), panning, effect sends, EQ, etc. Input and output 
busses are also shown in the mixer.

• There are 4 different mixer windows that can be configured to show 
different views of the mixer.
This allows you to e.g. control all audio channels in one window and all VST Instrument 
channels in another.

• Each audio channel in the mixer can carry up to 12 speaker channels.
Surround sound is fully supported in Nuendo; from the input busses via audio mixer 
channels to the output busses.
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Channel Settings

The Channel Settings window is used for adding effects and EQ to in-
dividual channels. Each mixer channel has its own VST Channel Set-
tings window.

Inserts section Equalizer section Sends section



NUENDO
Guided Tour 5 – 69

VST Connections

This is where you set up input and output busses – the audio connec-
tions between Nuendo and the inputs and outputs on your audio hard-
ware.
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About this tutorial

This chapter contains a step-by-step description of how to make a sim-
ple audio recording and play it back. The purpose is for you to try out 
some of the most common recording and playback features. However, 
you should make sure to read the Recording chapter in the Operation 
Manual before doing any “serious” recording, as there are a lot of set-
tings, options and methods that are not mentioned here.

Before you start

This chapter assumes that:

• You have installed and set up your audio hardware.

• Your audio source (a mixer or tape recorder, for example) is properly 
connected to the inputs of the audio hardware.

• The outputs of the audio hardware are connected to some sort of lis-
tening equipment, allowing you to listen to the recorded audio during 
playback.

• You are monitoring your audio source through Nuendo.
This means that when you are recording, the audio source is sent into Nuendo and then 
back out again to your monitoring equipment. This way of monitoring allows you to ad-
just monitoring levels from within the program, add effects to the monitor signal, etc. 
However, it also requires audio hardware with low latency – otherwise the monitored 
signal will be noticeably delayed.
Even if you find that the latency is too high for monitoring through Nuendo – please bear 
with us through this tutorial! In the Operation Manual you will find other methods for 
monitoring that may suit you better.

• You have launched Nuendo.
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Creating a new project

Before you can start recording, you need a working environment – a 
project:

1. Pull down the File menu and select “New Project”.
A dialog appears, listing a number of project templates for various purposes.

2. Make sure the “Empty” item in the list is selected and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will 
contain all files related to the project. 

3. Navigate to the desired location of the project folder, and select it by 
clicking OK, or click “Create” to create and name a new folder.
The project folder is created on disk, and an empty Project window appears.

At this point, you can make various settings for the project, such as 
sample rate, resolution, etc. However, to keep things simple we will 
use the default settings for now. 
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The next step is to create an audio track to record on:

4. Pull down the Project menu and select “Add Track”.
A submenu appears, listing the various types of tracks available in Nuendo.

5. Select “Audio”.
In the dialog that appears you can select the channel configuration for the track – 
mono, stereo or one of several different surround configurations.

6. In this example, set the track to stereo by selecting Stereo from the 
pop-up menu and clicking “OK”.
An empty audio track appears in the Project window.
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Preparing to record

Before you can start recording, there are some preparations to make:

Setting up input and output busses

When you record in Nuendo, the signal passes from the inputs on 
your audio hardware to an input bus in the program. This is where you 
check levels and adjust the sound to be recorded. From the input bus 
the signal is written to an audio file on your hard disk, and sent to the 
track’s channel in the mixer for monitoring etc.

You can have as many input busses as you like, but for this example 
we only need a stereo input bus:

1. Pull down the Devices menu and select “VST Connections”.
The VST Connections window appears. This is where you view, add and set up input- 
and output busses.

2. Select the “Inputs” tab by clicking on it.
By default, there is a stereo bus called “Stereo In” – if there wasn’t you could easily 
add one by clicking the Add Bus button.

Audio Hardware
Sound to be 
recorded

Input bus in Nuendo Mixer channel for 
the audio track

Audio file on hard disk
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3. Click the “+” button to the left so that the individual inputs in the bus 
are shown.
The ASIO Device Port column shows the physical inputs on your audio hardware that 
are used by the bus.

4. Click in the ASIO Device Port column for the “Left” channel.
A pop-up menu appears, listing all inputs on your audio hardware.

5. Select the input you want to use for the left channel in the stereo bus.

6. Select the input for the right channel in the same way.

7. Click the “Outputs” tab and set up a stereo output bus in the same 
way.
This is strictly not required for recording – but you need it for monitoring and for play-
ing back the recording afterwards.

8. Close the VST Connections window and open the Mixer from the 
Devices menu.
This is Nuendo’s Mixer window, used for setting levels, etc. The mixer contains channel 
strips for all tracks in the project and all input and output busses.
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• Right now the mixer should contain one input bus, one stereo audio 
channel and one output bus – just like the picture above. 
If not, check the Hide buttons to the left. If any of these is lit (red), click on it so that it 
goes grey.

When this button is red, the input busses are hidden.

9. At the very top of the channel strip for the audio track, you find an In-
put Routing pop-up menu. Click this and make sure your stereo input 
bus is selected.
The input bus is now routed to the audio track.

Leave the Mixer window open for now.
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Checking the input level

When you record digitally, it’s important to set the input level correctly. 
Above all, you don’t want the signal to be too loud, as this will cause 
clipping, digital distortion. 

Clipping can occur in two places:

• In the audio hardware.
This would be the case if the analog signal is too loud – clipping occurs when the sig-
nal is converted to digital in the audio hardware’s A/D converters.

• When the signal from the input bus is written to a file on your hard disk.
This would only happen if you made the signal louder in the input bus (by raising the 
bus level, adding effects or EQ, etc.).

To check the input level, proceed as follows:

1. Locate your stereo input bus to the left in the mixer.

2. Right-click (Windows) or [Ctrl]-click (Mac) somewhere in the Mixer 
window.
The Mixer context menu appears.

The input bus.
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3. Select the VU-Meter Settings submenu and make sure “Input VU” is 
activated.
Now the input bus meter displays the signal level coming in to your hardware – note 
that this level cannot be adjusted from within Nuendo!

4. Play the audio source that you want to record and check the level 
meter for the input bus.
The signal should be as loud as possible without exceeding 0 dB (the Clipping indica-
tor for the input bus shouldn’t light up).

5. Adjust the output level of your audio source so that the meters go as 
high as possible without going up to 0.0 dB.
Check the numerical peak level indicator below the meter in the bus channel strip. To 
reset the Clipping indicator and the peak level indicator, click on either one.

Now you’ve made sure there’s no clipping in the audio hardware.

6. Bring up the Mixer context menu again and select “Post-Fader VU” 
from the VU-Meter Settings submenu.
This is the “normal” metering mode which shows levels after the channel faders.

7. If you now play back the audio source you can check the output level 
of the input bus – the signal that is to be recorded on your hard disk.
Since we haven’t made any adjustments in the input bus there should be no risk of clip-
ping here. If you had made level adjustments in the input bus and the Clipping indicator 
lit up at this point, you would simply lower the input bus fader, reset the indicators and 
try again.

Clipping indicator

Numerical peak level indicator
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Making the track ready for recording

1. Click the “Record Enable” button next to the fader on the mixer chan-
nel strip, so that it lights up in red.

2. Make sure the Transport panel is visible.
If not, pull down the Transport menu and select the “Transport Panel” item at the top.

The Transport panel

3. The Transport panel contains a lot of options that affect how record-
ing is done – in this example we want most of them to be turned off. 
Check that the following buttons are off (grey or unlit):

Punch In and Punch Out deactivated. Cycle deactivated.

Click and Precount deactivated.

Sync deactivated.
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4. Click in the ruler (the time scale area above the track in the Project 
window), at the position where you want to start recording.
When you click, the project cursor (the black vertical line) is automatically moved to 
the click position. In our example, recording will start from the project cursor position.

Setting the project cursor position in the ruler.

5. To set recording to start at the cursor position, pull down the Trans-
port menu and make sure the item “Start Record at Left Locator” is 
deactivated (unticked).

Setting up monitoring

When you are monitoring through Nuendo, you can choose to activate 
monitoring manually or automatically, in several different ways. In this 
example we choose the “Tapemachine Style” monitoring, in which the 
input signal is automatically monitored in Stop mode and during record-
ing – but not during playback. This is convenient since it allows you to 
play back and listen to your recording without having to turn off moni-
toring first.

1. Pull down the File menu (Windows) or Nuendo menu (Mac OS X) and 
select “Preferences…”.

2. In the Preferences dialog, click the VST item to the left.
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3. Pull down the Auto Monitoring pop-up menu and make sure “Tapema-
chine Style” is selected.

4. Click OK to close the Preferences dialog.

5. Bring up the Mixer and locate the channel strip for the audio track.
Since the track is record enabled (the red button is lit) and Nuendo is in Stop mode, 
monitoring should now be activated.

6. Check the monitoring by playing back your audio source and listening 
to your monitoring equipment.
You should see the meters move in the channel strip for the audio track and in the out-
put bus to the right.

7. If you like you can adjust the monitoring level with the fader for the au-
dio track.
This will not affect the level in the recorded audio file.

You are ready to record!
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Recording

1. Start recording by clicking the Record button on the Transport panel.
The project cursor will start moving.

2. Play your instrument, etc.
During recording, a rectangle with an audio waveform will appear, covering the re-
corded area. This is the recorded audio event.

3. When you are done, click the Stop button on the Transport panel.
Recording stops and you can see the resulting audio event on the track.

4. If you are done recording, click the Record Enable button in the area 
to the left of the track, so that it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded audio event.
This could either be done by clicking in the ruler, or by using the Rewind button on the 
Transport panel.

2. Click the Play button on the Transport panel.
Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the 
Transport panel.
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Recording more events

At this point, you may want to continue recording audio, on the same 
track or on a new track.

Recording more on the same track

To record more audio on the same track, move the project cursor to a 
new start position and proceed as when you recorded the first time.

❐ It is possible to record audio events that overlap each other, but only the 
visible events (the events at the top) will be heard when you play back.

Recording a new audio track

This example shows how to record a new audio track, while listening 
to the first recording.

1. Create a new audio track by using the “Add Track” submenu on the 
Project menu.

2. Decide whether you want the new track to be stereo or mono in the 
dialog that appears.

3. Pull down the Devices menu and open the Mixer.
As you can see, a new channel strip has been added to the mixer.

4. Use the Input pop-up menu at the top of the channel strip to make 
sure that the same stereo input bus is selected for the new track.
If the audio source is another than the one you first recorded, you need to check the 
input level again – see page 78.

5. Record enable the new track by clicking the red Record Enable button 
in its mixer channel strip.
Make sure that the Record Enable button for the first track is disabled – otherwise you 
will be recording on both tracks at the same time.

6. Move the project cursor to the desired start position.

7. Activate recording by clicking the Record button on the Transport panel.
While you are recording, the first audio track is played back.

8. When you are done, click the Stop button on the Transport panel.
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Playing back in a cycle

You could continue starting and stopping playback this way, moving 
the project cursor manually each time. However, if you want to try out 
some mixing features (see the chapter “Tutorial 3: Mixing”), it is more 
practical to have Nuendo play back your recorded audio repeatedly, 
over and over again:

1. Click on the recorded audio event to make sure it is selected.
A selected audio event has a red border and red and blue handles at its beginning and 
end.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left and right locator (two special Nuendo markers) to the beginning 
and end of the selected audio event, respectively. In the ruler, the area between the left 
and right locator is indicated by a light blue highlight.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recording and click 
Play.
Playback starts. When the project cursor reaches the end of the recording (the right 
locator), it will immediately jump back to the left locator and continue playback. When 
you’re done, click the Stop button on the Transport panel.
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About this tutorial

This chapter describes the basic operations for recording and playing 
back MIDI. For a full description of MIDI recording please see the 
chapter “Recording” in the Operation Manual.

Before you start

This chapter assumes that you have correctly connected your MIDI 
equipment according to the instructions in the chapter “Setting up 
your system” in this book.

This tutorial connects to the previous chapter, so if you followed the 
instructions there, you should now have recorded two audio tracks.

About MIDI Thru

The normal way to work with MIDI is to have MIDI Thru activated in 
Nuendo, and Local Off selected in your MIDI instrument(s). In this 
mode, everything you play during recording will be “echoed” back out 
again on the MIDI output and channel selected for the recording track.

1. Open the Preferences dialog and select the MIDI page.
The Preferences dialog is located on the File menu under Windows and on the 
Nuendo menu under Mac OS X.

2. Make sure the option “MIDI Thru Active” is activated, and follow the 
steps below.
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Setting up for recording MIDI

Creating a MIDI track

To create a MIDI track, proceed as follows:

1. Pull down the Project menu, and select “Add Track”.
A submenu appears.

2. Select MIDI from the submenu.
A MIDI track is added to the Track list.

Setting the MIDI input 

1. Make sure the Inspector is shown to the left in the Project window.
The Inspector shows settings for the selected track. You show or hide it with the Show 
Inspector button on the toolbar.

Click here to show the Inspector.

2. To set the MIDI input for a track, pull down the “in:” pop-up in the 
Inspector and select an input.
The available MIDI inputs are shown. The items on the menu depend on the type of MIDI 
interface you are using etc. You can set the MIDI input independently for each track.

Click here to set the MIDI input.
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3. Record enable the MIDI track by clicking the red button in the Track 
list.
MIDI Thru is automatically activated when the track is record enabled.

Record enabling the track in the Track list. This can also be done in the Inspector 
area to the left or in the mixer.

4. Play a few notes on your MIDI instrument, and check the level meter in 
the Track list to make sure that the MIDI signal is received.
If not, check that you have correctly set up your MIDI system, as described on page 49.

Setting the MIDI output and channel

1. To set the MIDI output for a track, pull down the “out:” pop-up in the 
Inspector and select the output to which you have connected your 
MIDI device.
The available MIDI outputs are shown. The items on the menu depend on what type of 
MIDI interface you are using etc. 

Click here to set the MIDI output.
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2. To set the MIDI channel for a track, use the MIDI “chn:” pop-up in the 
Inspector.
If you set the track to MIDI channel “ANY”, it will transmit MIDI on the channel(s) used 
by the MIDI input device (the MIDI instrument you play during recording). 

Click here to set the MIDI channel.

Selecting a sound

• To select different sounds, you can send Program Change messages 
to your MIDI device using the “prg:” value field in the Inspector.

Click here to select a Program number.

Program Change messages give access to 128 program locations. If 
your MIDI instruments have more than 128 programs, Bank Select 
messages (set in the “bnk:” value field) allow you to select different 
banks, each containing a number of programs.

• Play a few notes on your MIDI instrument to check that the selected 
sound program is correct.
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Recording MIDI 

1. Make sure the track is record enabled and correctly set up, as de-
scribed in the previous section.

2. Make sure that Cycle and Punch In/Out are deactivated on the Trans-
port panel.

3. To set recording to start at the cursor position, pull down the Trans-
port menu and make sure the item “Start Record at Left Locator” is 
deactivated (unticked).

4. Place the project cursor at the position where you wish to begin re-
cording.
For example, you could try recording a MIDI part together with the audio tracks that 
you recorded in the previous tutorial.

5. Activate Record on the Transport panel, and play a few notes on your 
MIDI instrument.
When you finish recording, a MIDI part containing MIDI events is created in the 
Project window. 

6. If you are done recording, click the record enable button in the area to 
the left of the track so it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded MIDI part.
This could either be done by clicking in the ruler, or by using the Rewind button on the 
Transport panel.

2. Click the Play button on the Transport panel.
Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the 
Transport panel.
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Playing back in a cycle

You could continue starting and stopping playback this way, moving 
the project cursor manually each time. However, it is more practical to 
have Nuendo play back your recorded parts and events repeatedly, 
over and over again:

1. Click on the recorded MIDI part to make sure it is selected.
A selected MIDI part has a red border and red handles at its beginning and end.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left and right locator to the beginning and end of the selected MIDI 
part, respectively. In the ruler, the area between the left and right locator is indicated by 
a blue line.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recorded part and 
click Play.
Playback starts. When the project cursor reaches the end of the recording (the right 
locator), it will immediately jump back to the left locator and continue playback. When 
you’re done, click the Stop button on the Transport panel.
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Transposing the MIDI track

Let’s try transposing the MIDI track, using the Track Parameters tab in 
the Inspector:

1. Make sure that the Inspector button on the toolbar is lit.

2. Select the MIDI track by clicking on it in the Track list.
The parameters for the MIDI track are now shown in the Inspector area to the left.

3. Click on the Track Parameters tab in the Inspector.

Click here…
…to open the Track Parameter 
settings in the Inspector.
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4. Click on the blue value line in the Transpose field in the Inspector.
A fader appears, allowing you to transpose the MIDI part up or down in semitones. You 
can also use the up/down arrows to the right in the value field to set transpose values.

Click here…

…to set a transpose value for the MIDI part.

5. Start playback to hear the transposed MIDI part.
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About this tutorial

This tutorial shows how to do some basic mixing. You will set levels and 
pan, add effects and EQ and finally try automating a mixer parameter. The 
purpose of the tutorial is to give you some basic knowledge about the 
Nuendo Mixer – for complete descriptions of the mixing features please 
refer to the chapters “The Mixer”, “Audio Effects” and “Automation” in the 
Operation Manual.

• In this tutorial we will mix in stereo – for a quick tutorial on how to do a 
surround mix, see page 115.
We recommend that you are familiar with the procedures in this chapter before moving 
on to the surround tutorial.

Preparations

This tutorial is based on a file included on the Nuendo CD. Proceed 
as follows:

1. Insert the Nuendo CD and open it for browsing.

2. On the CD, open the “Demo Projects” folder and locate the folder 
“Nuendo Tutorial”.

3. Copy this folder to the computer’s hard disk (for example in the “My 
Documents” folder under Windows).

4. Open the Nuendo Tutorial folder on your hard disk and double click 
on the file “Tutorial 3.npr”.
Whether file extensions are shown or not depends on the settings for your operating 
system.

The “Tutorial 3” project opens in Nuendo. This is a simple 16-bar “song” 
containing four audio tracks.

• Since this project doesn’t contain any MIDI tracks, we will only mix au-
dio in this tutorial. 
If you have MIDI tracks in a project, these will also show in the mixer. Many procedures 
(setting levels, pan, mute, etc.) are the same for MIDI mixer channels – see the Opera-
tion Manual.
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The Tutorial 3 project.

• If you had another project open, make sure the new project is in the 
foreground and click the Activate button in the upper left corner of the 
Project window so that it is lit (blue).
This button indicates which project is active when you have several projects open.

5. Click Play to play back the project.
As you hear, this is a low-tempo, medium-funky piece consisting of a drum track, a 
bass track, some electric piano and strings. Cycle is activated on the Transport panel, 
which means the 16 bars of music will play back repeatedly. The balance, pan and 
general sound isn’t the best – that’s what we will try to change on the following pages.

• If you don’t hear all four tracks, make sure you have a stereo output bus 
(in the VST Connections window – see page 75) and that all four tracks 
are routed to this bus in the mixer.

All four tracks routed to the Stereo Out bus.
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Setting levels
If you listen to the project, you will find that the level balance is fairly 
OK until the strings start in bar 9. The strings are way too loud, tending 
to drown the other tracks. Proceed as follows:

1. Open the Mixer by selecting it from the Devices menu (or by using the 
key command for this – by default [F3]).
The Mixer window opens with channel strips for the four audio tracks. Had the 
project contained any other tracks (MIDI tracks, effect tracks, etc.) or VST 
instruments, there would have been channel strips here for these as well. 

2. Start playback and locate the channel strip for the Strings track.
The names of the tracks are shown at the bottom of each channel strip.

3. Click the level fader handle in the channel strip and lower the fader 
until you feel the level of the Strings track is OK.
As you can see, the level meters reflect the signal level of each track – the meter for 
the Strings track will reflect the level change you make.

• If you need to reset a level fader to ±0.00, press [Ctrl]/[Command] 
and click on it.
You can use this method to reset most parameters to their default values.

4. If you like, you can adjust the levels of the other tracks as well.

If you like, you can leave the project playing for the next steps in the 
tutorial.
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Setting pan

Pan sets the left/right position in the stereo field or the stereo balance.

Right now, all tracks are set to center pan. This is probably fine for the 
drums and the bass, but it might be a good idea to pan the piano and 
strings tracks to opposite sides:

1. In the “E.Piano” channel strip, click on the blue line in the Pan control 
box above the fader, and drag it a bit to the left.
The electric piano track is panned to the left.

2. Pan the strings track a bit to the right in the same way.

These are both mono tracks which means the pan control simply pans 
the mono signal between the left and right channel in the output bus. 
For stereo tracks, the pan control serves as a stereo balance control 
by default, but two other panning modes are available – see the Oper-
ation Manual for details.
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Using Mute and Solo

Each channel strip has a Mute and a Solo button, allowing you to 
silence one or several channels.

1. Click the M button for the bass track.
The button lights up and the sound of the bass is muted.

2. Mute the electric piano track in the same way.
Several channels can be muted at the same time.

To unmute a channel you click its M button again. You can also un-
mute all muted channels in one go:

3. Click the lit M button in the common panel – the area at the left side of 
the Mixer window.
This button is lit whenever one or several channels are muted – clicking it unmutes all 
muted tracks.

4. Now click the S button for the drum track to solo it.
This mutes all other channels.

5. To turn off solo for the channel, click the S button again...
...or click the lit S button in the common panel – this turns off solo for all channels.

• You can solo several channels at the same time.
If you instead press [Ctrl]/[Command] and click an S button, that channel will be so-
loed and all other channels will be muted. This function is known as exclusive solo.
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Adding EQ to an audio channel

Equalization shapes the tone of a signal by boosting and/or cutting 
selected frequencies. Each audio channel in the mixer has a built-in 
equalizer with four parametric modules. 

When and how to apply EQ is of course individual. Below we will add 
EQ to two channels, to achieve the following:

• Cut a very narrow frequency band in the drum track to reduce the intensity of 
the rimshot.

• Add a gentle mid frequency boost to the electric piano track to make it stand 
out a bit more.

First we need to extend the mixer to show the EQ panel.

1. Locate the small diagram in the lower left corner of the Mixer window.
The three sections in the diagram correspond to the different panels in the mixer – the 
fader panel, the extended panel and the input/output panel. By clicking on the diagram 
you can hide or show mixer sections.

Shows/hides the input/output panel

Indicates the fader panel 
(which cannot be hidden)

Shows/hides the extended panel
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2. Click the middle section of the diagram so that it lights up.
The mixer is extended to show the extended panel, which contains the EQ modules. 
This is the default, but you can select other settings to be shown in the extended panel.

Let’s start with the rimshot which is mixed rather loud in the drum 
track. Unfortunately we cannot change this but we could try cutting a 
narrow band in the mid-high frequencies.

3. If you like, solo the drum track to help you hear what you’re doing.

4. In the channel strip for the drum track, click the on/off button for the 
“hi mid” EQ module to activate it.
You can activate up to four modules per channel, but in this case we only need one.

From top to bottom, the three sliders in each EQ module govern gain 
(cut or boost), mid frequency for the range to be cut or boost and Q – 
the width of the range to be affected.
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5. Set the gain slider to a fairly drastic cut, around -10 dB or so.
This is done by clicking and dragging the slider to the left.

6. Raise the Q value (the lowest slider) to 12.0 – the maximum value.
This means the frequency range will be as narrow as possible.

7. Experiment with the frequency slider and try to find a frequency where 
you reduce the intensity of the rimshot without interacting too much 
with the other drums and hi-hat sounds.
To make fine adjustments, press [Shift] and drag the slider. You can also click the nu-
merical value and type in a frequency directly.

This setting should produce a fairly good result.

8. Turn off solo to see how the drum sound works with the other tracks.

When you activated the EQ module, the EQ indicator in the channel 
strip lit up. This shows that one or several EQ modules are activated 
for the channel, and also serves as a bypass button:

9. To compare the sound with and without EQ, click the EQ Bypass but-
ton in the channel strip.
The button turns yellow when activated – this means the EQ section is bypassed. Of 
course, in this case we could simply turn off the EQ module with its on/off button, but 
the bypass button is handy when you have more than one EQ module activated.
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There are several ways to add and set up EQ in Nuendo, as described 
in the Operation Manual. Now we will try another method when add-
ing EQ to the electric piano track.

10.Click the “e” button in the “E.Piano” channel strip (next to the fader).
This opens the Channel Settings window for the channel.

This window contains a channel strip, sections for insert effects and 
send effects and an EQ section (in the middle of the window). Here 
you can make EQ settings by using knobs or graphically, in the EQ 
curve display:

11.Click in the curve display and keep the mouse button pressed.
A curve with a point appears, and one of the EQ modules below is activated. The num-
ber next to the curve point is the number of the EQ module.
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12.While listening to the electric piano sound, drag the curve point to 
change gain and frequency.
Q is set to a low value by default – this is probably good in this case. If not, you can 
change the Q value by pressing [Shift] and dragging in the display (or by using the Q 
knob in the EQ module below).

• Clicking somewhere else in the curve display will activate another EQ 
module for a more complex curve.
You can remove EQ curve points by clicking and dragging them outside the display.

13.When you’ve set the EQ as desired, close the Channel Settings 
window.

Those were two methods of making EQ settings. You can also use the 
“EQs +” panel in the extended mixer (works the same as the regular 
EQ panel but with knobs instead of sliders) or make EQ settings in the 
Inspector in the Project window.

Audio effects

Nuendo comes with a large number of audio effect plug-ins (VST plug-
ins). These can be used as send effects, insert effects or for offline pro-
cessing (described in another tutorial in this book).

Adding a send effect

Send effects in Nuendo make use of FX channel tracks – “effect return” 
tracks, each holding one effect plug-in (or several, in series). Each au-
dio track has eight different effect sends, which can each be routed to 
any FX channel track. This allows for extremely flexible effect handling.

In brief, this is what you do to add a send effect to an audio track:

• Create an FX channel track and select an effect plug-in for it.
• Activate a send for the audio track and route it to the FX channel track.
• Adjust the amount of effect for the track with the effect send.
• Adjust the amount of effect return signal by setting the level of the FX channel 

track.
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In this project, we feel that the strings track could use some reverb. 
Proceed as follows:

Setting up an effect

1. Pull down the Project menu and select “FX Channel” from the “Add 
Track” submenu.
A dialog appears.

2. Set the Configuration pop-up menu to “Stereo”.

3. Pull down the Plugin pop-up menu.
The effects included with Nuendo are organized in subfolders according to the effect 
type. Typical send effects are reverb, delay and other effects where you want to add a 
little bit of effect to the original dry signal.

4. Select “Reverb A” from the Reverb submenu.
An FX channel track is added to the Track list. As you can see in the Track list, the in-
sert effect button is lit for the track – this indicates that an insert effect is loaded and 
activated for the track.
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5. Go back to the mixer – as you can see, a channel strip has been 
added for the FX channel track.
This serves as an effect return control.

6. Click the “e” button for the FX channel strip.
The Channel Settings window appears.

The first insert effect slot holds the Reverb A plug-in.

7. Click the “e” button for the Reverb A slot to bring up the control panel 
for the effect.

8. Use the pop-up menu to select the “Large” preset.

9. Since we want to use this as a send effect we don’t want any dry (un-
processed) signal to pass through the effect – drag the Mix slider fully 
down (wet 100, dry 0).
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Setting up a send

1. Go back to the mixer and locate the channel strip for the Strings track.

2. Click the arrow between the fader panel and the extended panel, just 
above the pan control.
This brings up a pop-up menu where you select what should be shown in the extended 
panel.

3. Select “Sends”.
Now the extended mixer panel for the Strings track shows eight effect sends, each 
with a few buttons, a routing pop-up menu and a send level slider.

4. Click in the field below the buttons and select your FX channel from 
the pop-up menu that appears.

5. Click the power button for the first slot to activate the send.

6. Listen to the strings while you raise the send slider.
You will hear the reverb effect being added to the sound.

7. If you like, you can adjust the effect return level with the level fader for 
the FX channel strip.
You could also add EQ to the FX channel, change its stereo balance etc., just like for 
a regular audio track.

• Note that you can activate sends for other tracks in the same way, and 
route them to the same reverb effect.
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Adding an insert effect

An insert effect is inserted into the signal chain of an audio channel, 
which means that the whole channel signal passes through the effect. 
This also means that only one track or channel will use the insert effect 
– unlike send effects, where signals from several channels can all be 
sent to the same effect.

In our tutorial we will add some chorus to the electric piano track.

1. In the “E.Piano” channel strip, click the arrow between the fader panel 
and the extended panel, to bring down the pop-up menu.

2. Select “Inserts”.
The extended panel will now show eight insert effect slots.

3. Click in the empty field in the first insert slot.
This brings up the effect pop-up menu.

4. Select “Chorus” from the Modulation submenu.
The effect is loaded and automatically activated, and its control panel appears.

5. Play back the project and try selecting different chorus presets.

• In this case we inserted an effect on a mono track – this means the out-
put from the effect will still be in mono.
To get a stereo chorus, we would need to add the chorus as a send effect instead.
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Automation

All mixer parameters can be automated in Nuendo. In the final example 
in this chapter, we will do a simple fade in for the electric piano track, 
so that it starts inaudible and reaches its full level at bar 9, where the 
strings start:

1. Arrange your windows so that you can see both the events in the 
Project window and the mixer.
This is not strictly necessary but it makes it easier to see where the electric piano starts.

2. Turn off Cycle on the Transport panel.
This is a safety measure to avoid accidentally overwriting your automation.

3. Move the song position cursor to the start of the project.
You can do this by clicking in the ruler at the project start, or by clicking the “Goto Zero” 
button on the Transport panel (to the left of the Rewind button).

4. In the mixer, click the W button for the “E.Piano” channel.
This activates automation write mode.

5. Start playback.

6. Drag the level fader for the “E.Piano” channel fully down.

7. When the song position cursor reaches the electric piano event, start 
slowly raising the level fader, so that it reaches full level (0.00) roughly 
at the start of bar 9.

8. Stop playback.

9. Click the W button to turn it off.
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10.Click the R button for the channel.
This activates automation read mode.

11.Play back the project from the start.
You will see your automated fader movement and hear the electric piano fade in.

That concludes this tutorial! If you are happy with the result, you may 
want to save the project under a different name, by selecting “Save As...” 
from the File menu.
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About this tutorial

This tutorial describes how to set up Nuendo for work in 5.1 surround 
format, add some audio files from a library, create a simple surround 
mix including some mixer automation and finally export this as an inter-
leaved multi-channel audio file.

For full descriptions of all the surround features in Nuendo, please see 
the Surround chapter in the Operation Manual.

• For this tutorial to be useful, you need to have audio hardware with six 
(or more) outputs.
Preferably, these outputs should be connected to a surround speaker system in 5.1 
configuration.

Preparations

This tutorial is based on an existing file, included on the Nuendo CD. 

• Below, we assume that you have followed the previous tutorial and cop-
ied the “Nuendo Tutorial” folder to your hard drive.
If not, please see page 98.

Before you start, close any open projects, by making their Project win-
dows active and selecting “Close” from the File menu. This is just to 
make things clear and avoid confusion – you can have several projects 
open in Nuendo if needed.

Creating a Project

First of all, we need to create a new project.

1. Pull down the File menu and select “New Project”.
A dialog appears, listing a number of project templates for various purposes.

2. Make sure the “Empty” item in the list is selected and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will 
contain all files related to the project. 
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3. Navigate to the desired location of the project folder, and select it by 
clicking OK, or click “Create” to create and name a new folder.
The project folder is created on disk, and an empty Project window appears. 

4. Pull down the Project menu and select Project Setup.
The Project Setup dialog appears. This is where you make basic settings for the 
project.

5. Set the Sample Rate to 48.000 Hz and the Record Format to 24 bit.
This is to match the audio files we will use.

6. Click OK to close the Project Setup dialog.

The project is empty right now so we need to add some audio tracks. 
In previous chapters we did this by selecting “Add Track” from the 
Project menu – here’s a quicker way that works for audio tracks:

7. Double click in the empty Track list.

8. Make sure Stereo is selected in the dialog that appears and click OK.
A stereo audio track is created.

9. Create another stereo track in the same way.
Make sure to double click in an empty part of the Track list.
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10.Create two mono tracks as well.
Use the same method, just select Mono in the dialog that appears.

Now we have two stereo tracks and two mono tracks, which is what 
we need.

11.Pull down the File menu and select “Open Library”.

12.Navigate to the “Nuendo Tutorial” folder on your hard disk and open 
the file “Tutorial 4.npl”.
This is a library – a stand-alone Pool with references to media files (in this case, the li-
brary contains four audio clips). Typically, you create libraries with audio clips and/or 
video clips that you want to use in several projects – sound effects libraries, etc.

13.Position the windows so that you can see the Project window and the 
Library window at the same time.
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14.Turn on Snap in the Project window and make sure the Grid option is 
selected to the right.
This makes it easier to line up the events at the same start position, where needed.

15.Drag the clip “Ambience 1” from the library to the first stereo track 
and drop it at the start of the project.
You will be asked whether to copy the file to the work directory, etc. – this is not nec-
essary.

16.Proceed in the same way with the clips “Ambience 2” (on the second 
stereo track), “Speech” and “Car” (each on one mono track). Position 
the clips roughly like on this picture:

17.Now, change the track names accordingly: in the Track list, double-
click the name field and enter the respective name (“Ambience 1”, 
“Ambience 2”, etc.).

If you were to play back the project at this point, all four tracks would 
simply play back through the default stereo output bus. It’s time to set 
up a surround bus.
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Creating a surround bus

1. Select “VST Connections” from the Devices menu.

2. In the VST Connections window, make sure the Outputs tab is se-
lected and click the Add Bus button.

3. In the dialog that appears, select the 5.1 option and click OK.
The pop-up menu in the dialog lists the most common formats – to see all surround for-
mats supported by Nuendo, check the “More...” submenu.

The new bus appears.
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4. Click in the ASIO Device Port column for each channel in the bus and 
select outputs on your audio hardware.
If you followed the recommendations on page 47, your output ports will already be 
named according to the channels in your surround setup – this way you just have to 
select the “Left” output for the left channel, the “Right” channel for the right channel 
and so on.

Now we have a 5.1 output bus. As you will see, you can either route a 
mono track directly to one channel in the surround bus or route a track 
(mono or stereo) to the whole surround bus and use the Surround-
panner to position it as desired. But what if you have some stereo ma-
terial that you simply want to send to a stereo channel pair in the bus 
(Left and Right or Left Surround and Right Surround)? For this you 
need to create a child bus:

5. Select the new 5.1 bus in the list and right-click (Windows) or [Ctrl]-
click (Mac) on it.

A pop-up menu appears.

6. Select “Add Child Bus” and from the submenu that appears, “Stereo 
(Ls Rs)”.
This creates a stereo child bus within the 5.1 bus, directed to the left and right sur-
round speakers. Often you would have more need for a child bus to the left and right 
front speakers, but this is what we need in this tutorial.

7. Close the VST Connections window.
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Setting up a surround mix

If you have auditioned the audio clips already, you have found that we 
have a stereo clip with background noise from a petrol station (Ambi-
ence 1), a similar stereo clip (Ambience 2), some speech in mono and 
the sound of a car starting and driving away, also in mono. 

• These audio files are (except for the speech clip) based on excerpts 
from Steinberg’s “Urban Atmospheres” sound environment record-
ings in 5.1 surround format.
Please check out www.steinberg.net for more information on the Urban Atmospheres 
collection!

Our goal here is to set things up like this:

• The speech track goes to the Center channel only.
• The Ambience 1 track goes to the Left and Right channels.
• The Ambience 2 track goes to the surround speakers only.
• The sound of the car will be panned across the surround speakers, and we 

will send a bit of it to the LFE channel as well.

Proceed as follows:

1. Open the mixer.

The mixer contains channel strips for the four audio tracks as well as a channel strip 
for the 5.1 output bus you created.
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2. Make sure the Input and Output Settings panel is visible at the top of 
the channel strips.
If not, click in the upper part of the symbol in the lower left corner of the mixer.

Surround panning in stereo

Let’s start with the Ambience 1 track (the first stereo track). We want 
this routed to the front stereo speakers only. To get a feeling for how 
things work we will do this by using the surround panner:

1. Locate the channel for the Ambience 1 track and solo it by clicking the 
“S” button.
This is for listening to the track by itself.

2. Open the Output Routing pop-up menu for the track.
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3. Select the 5.1 bus (“5.1 Out”).
This routes the track to the whole 5.1 bus, for surround panning. As you can see, the 
regular pan control on the channel strip is replaced by a square grid with a dot.

4. Double click on the grid to bring up the surround panner panel.

The grey ball in the middle of the display indicates the position of the signal in the 
surround sound image.

5. Click on the “Mo./St.” pop-up menu and select “Y-Mirror”.
In this mode, the left and right channels in the stereo material will be “mirrored” along 
the Y axis. That is, the same amount of signal will be sent to the surround channels for 
both channels.
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6. Click and drag the ball to the top right corner of the display.
As you see, you are dragging the “R” ball – the right channel. The left channel is auto-
matically mirrored and is therefore positioned in the top left corner.

7. Start playback from the beginning of the project.

8. Click the “R” ball and drag it slowly downwards – towards the sur-
round (back) speakers.
You will hear the sound gradually move back to the surround speakers.

9. Position the balls in the upper corners again, as in the picture above.
This is what we want in this case – the left and right channels routed to the left and 
right speakers, respectively.

10.Go back to the mixer.
You can close the surround panner if you like.

Routing to a stereo child bus

Next up is the Ambience 2 stereo track, which should be routed to the 
surround speakers. We could use the surround panner again, but 
since we created a child bus for the left and right surround speakers, 
this is a much quicker way:

1. Unmute the Ambience 2 channel.

2. Pull down the Output Routing pop-up menu for the channel.
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3. Select the “Stereo (Ls Rs) out” child bus.
This routes the track directly to the surround stereo speakers.

4. Play back the project again.
You should hear a recording of the ambient noises on a petrol station, with the rear 
speakers providing life-like depth and surround sense.

Routing to a separate channel in the bus

The speech track should be routed to the center channel only in this 
tutorial. This is easily done:

1. Unmute the speech channel and open its Output Routing pop-up menu.

2. Select the “Center” channel for the 5.1 Out.

3. Play back the project and check that the speech is heard from the 
center speaker.
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LFE and dynamic surround panning

For the final track, the car sound, we want a sense of movement across 
the surround sound image. We do this by automating the surround 
panner.

1. Unmute the car channel and pull down its Output Routing pop-up 
menu.

2. Select the 5.1 Out option.
This routes the track to the whole 5.1 bus, for surround panning.

3. Double click on the grid to bring up the surround panner panel.
This time we’re working with a mono track, so we can keep the “Mo./St.” parameter set 
to “Mono Mix”. This means there will be a single ball, indicating the position of the sound 
source.

Before we set the surround panning, let’s try sending some sound to 
the LFE (low frequency effects) channel:

4. Click the LFE knob in the surround panner panel and turn it up to a 
moderate level.
This knob controls the amount of signal sent from the car channel to the LFE channel. 
If you like, play back the project and adjust the LFE amount.

Now on to the surround panning:

5. Position the ball at “where you want the car to start”.

6. Start playback.

7. While the car sound plays back, try dragging the ball to get a natural 
sense of movement.
You may for example start at one side and drag the ball in a semi-circular movement 
across the lower part of the display.

Practice this a few times to find the best panning sweep.

8. In the mixer, click the “W” button for the car channel to enable auto-
mation writing.
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9. Play back the project and perform the panning sweep in the surround 
panner.

10.When you are finished, click Stop, turn off the “W” button and activate 
the “R” button.

11.Play back the project again.
Now you should hear the complete surround mix, including your automated panning 
sweep.

12. If you like what you hear, save the project.

Exporting to a surround audio file

Nuendo can export (mix down) audio tracks to a file on hard disk in a 
number of formats. Most often you will probably export to stereo or 
mono files, but it’s also possible to create an interleaved multi-channel 
file, containing all the surround channels in a single file:

First you need to set up the left and right locators to encompass all 
audio files in the project. Here’s one way to do this:

1. Click in the upper half of the ruler at the very start of the project and 
drag to the right with the mouse button pressed.

2. Release the mouse button at the end of the last event.
Check that all events are contained within the area between the locators (indicated 
with a blue highlight in the ruler).

• You can also do this by pressing [Ctrl]/[Command]-[A] + [P].
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3. Pull down the File menu, select “Export” and then “Audio Mixdown” on 
the submenu that appears.
The Export Audio Mixdown dialog appears.

4. Enter a name for the mixdown file in the File name field.

5. Make sure an uncompressed file type is selected.
You can only create multi-channel interleaved files in uncompressed format. These in-
clude Wave, Wave 64 and Broadcast Wave (PCM coding) as well as AIFF.

6. Select 48kHz in the Sample Rate field – the same as in the project.
This is only necessary because we will import the resulting file back into the project 
again. The Resolution setting isn’t as important, but to maintain the high audio quality 
you should set this to 24 Bit.

7. Pull down the Channels pop-up menu and select “N. Chan. Interleaved”.
This option is for creating a multi-channel interleaved file. Note that it’s also possible to 
export in Split format, in which case each channel in the surround bus will become a 
separate mono file.
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8. Pull down the Outputs pop-up menu and select your 5.1 Out bus.
This is where you select which output bus to export. As you can see, it’s also possible 
to export separate audio tracks here (as well as VST Instrument channels, effect return 
tracks etc.).

9. Turn off the Real-Time Export and Update Display options.

10.Make sure both “Import to” checkboxes are activated.
This means the resulting mixdown file will be imported back into the project, on a new 
audio track.

11.Click Save.

Now Nuendo renders the output bus to a file, which may take a few 
moments. Then the file will be imported into the project. 

• A dialog will ask you whether to copy the file into your work directory, 
etc. but this is not required now – deactivate all checkboxes and click 
OK.

If you look at the Project window now, you will find that a new track 
has been added. While the other tracks are in stereo or mono format, 
this one is a 5.1 track, containing six channels. The track contains an 
audio event with the exported surround file.

12.Open the mixer and make sure the new 5.1 track is routed to the 5.1 
Out bus.

13.Solo the 5.1 channel and play back the project.
You will hear your surround mix again, although now it’s contained in one multi-channel 
audio file.

That concludes this tutorial! In the Operation Manual you can read 
more about the extensive Surround features in Nuendo.
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About this tutorial

This tutorial describes some of the procedures for editing in the Project 
window. Typically, this is where you do the “large-scale” editing and re-
arranging of events. Again, please note that this tutorial only describes 
some of the many functions in the Project window – for details and full 
descriptions, see the Operation Manual.

Preparations

This tutorial is based on an existing file, included on the Nuendo CD. 

• Below, we assume that you have followed the previous tutorial and cop-
ied the “Nuendo Tutorial” folder to your hard drive.
If not, please see page 98.

1. Close any open projects, by making their Project windows active and 
selecting “Close” from the File menu.
This is just to make things clear and avoid confusion – you can have several projects 
open in Nuendo if needed.

2. Pull down the File menu and select Open.

3. In the file dialog that appears, navigate to the “Nuendo Tutorial” folder 
on your hard drive, select the file “Tutorial 5.npr” and click Open.

Now the “Tutorial 5” project opens in Nuendo.
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Overview

As you can see, this project contains four audio tracks (drums, bass, 
guitar and strings) with a few events. Try playing back the project from 
the beginning!

Well, it’s obvious that things are pretty disorganized here; the audio 
events do not fit together very well. The goal of this tutorial is to make 
some sense out of this, by editing in the Project window.

❐ While this tutorial describes editing audio events, most of these proce-
dures can also be used for editing MIDI parts in the Project window. See 
the Operation Manual for details.
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Moving and copying events

Let’s start by making the events start at the same time:

1. Select the Arrow tool by clicking its icon in the toolbar.

2. Make sure the Snap button is activated and the Grid option is selected 
on the Snap pop-up menu.

Snap helps you find the correct positions when moving and editing, by 
making objects “magnetic” to certain positions (or to other objects). 
When the Grid option is selected and the Grid pop-up menu to the 
right is set to “Bar” as in the figure above, you can only move objects 
to the start of bars.

3. Click on the first Bass Synth event, and drag it all the way to the left.
Now it will start at the same time as the “Slow Disco” drum event.

4. Drag the next Bass Synth event so that it starts where the first one 
ends.

5. In the same way, drag the Guitar event and the Strings event so that 
they start at the beginning too.

6. Move the project cursor to the start of the project and play back.

The Snap button
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OK, that’s much better, but there are still things to fix. For example, the 
Wah guitar event ends after one bar, while the other events last two 
bars. Let’s add a copy of the guitar event:

7. Press [Alt]/[Option], click the Wah guitar event and drag it one bar to 
the right.
A copy of the event is created.

Now we have a two-bar, slightly cheezy disco pattern. We could just 
activate Cycle playback and listen to these two bars over and over 
again. Instead we’ll use the Repeat function:

8. Select all events by pressing [Ctrl]/[Command]-[A] on the computer 
keyboard.
This is the same as using the Select All function on the Edit menu. You can also select 
multiple events by [Shift]-clicking each event in turn or by dragging a selection rectan-
gle around them with the Arrow tool.

9. Pull down the Edit menu and select “Repeat…”.
A dialog appears.

10.Set the “Count” parameter to 3 and click OK.
All events are repeated three times, for a total of four two-bar patterns. This is just the 
same as copying by [Alt]/[Option]-dragging, but much quicker, especially if you need 
several copies after each other.

At this point, our song is eight bars long. It could use some variation!
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Muting and erasing events

A quick way of adding variation is to remove stuff. We could for exam-
ple let the different instruments appear gradually instead of all at the 
same time:

1. Select the Mute tool from the toolbar.

2. Click on the first two Bass Synth events, and then on the first two 
Hi Strings events.
They are “greyed out” indicating that they’re muted.

3. Start playback from the beginning.
Fine, now the bass appears at bar 3 and the strings at bar 5.

The Mute tool is very useful for trying out variations, etc. However, now 
that we’re sure that we want to remove those events, we might as well 
delete them for real:

4. Select the Eraser tool from the toolbar.

5. Click on the four muted events.
They are removed.

6. While you’re at it, remove the first and the second Wah guitar event too.
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Splitting and resizing events

Well, maybe that wasn’t such a good idea after all – it may have been 
better with some guitar at the beginning, but maybe with some varia-
tion. Here’s an idea:

1. Pull down the Edit menu and select Undo.
The last deleted guitar event reappears.

2. Select Undo again.
The first guitar event reappears. 

Nuendo has unlimited undo – you could go back all the way to the 
start of this tutorial by undoing your actions, if needed. However, we 
will only need one guitar event for this:

3. Select Redo from the Edit menu.
The first guitar event is removed again.

4. Select the Scissors tool from the toolbar.

Now, the idea is to split the Wah guitar event into smaller sections, to 
vary them. However, currently you can only make edits at whole bar 
positions because the Snap Grid is set to “Bar”.

5. Pull down the Grid pop-up menu on the toolbar and select “Beat”.
Now you will be able to split or position events at each beat (quarter note) position.
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6. Click with the Scissors tool at the fourth beat in the Wah guitar event 
(at the beat just before the start of bar 3).
The event is split in two; one three beat long and another one beat long. If you were to 
play back this section now, you wouldn’t hear any difference, though.

7. Select the Arrow tool again.

8. Drag the first guitar event two beats to the left and play back.
Not too bad, but we could use a little more guitar in the second bar:

9. Position the pointer in the lower left corner of the second guitar event 
(the one bar long event).
The pointer is shown as a double arrow, indicating that you can resize the event by 
dragging.

10.Click and drag one beat to the left.
What you did was to resize the event. In effect, you make the event start playing earlier 
in the audio clip. Events could be viewed as “windows” looking into an audio clip – by 
resizing an event you get to see more or less of its clip.

OK, that brought some variation to the start of the “song”.
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Adding a fade

The strings in bar 5 appear rather abruptly – they would benefit from 
being faded in. In the Mixing tutorial we created a fade by automating 
a fader – let’s try another method instead:

1. Click on the first Hi Strings event with the Arrow tool.
The event is selected. The blue handles at the top are fade and volume handles.

2. Click at the upper left handle and drag it to the right.
A thin blue line indicates the fade-in.

3. Play back to hear the fade.
You can adjust the length of the fade by dragging the handle. 

It’s not bad, but it would be even better if the fade-in was slower at the 
beginning and quicker at the end (i.e. more exponential).

4. To change the shape of the fade, double click on the fade line.
This opens a dialog in which you can adjust the fade settings:
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5. Click one of the buttons to the right below the curve display to get a 
more exponential fade curve.

6. Click OK to close the dialog and play back the section again.

Now we would want the same fade to be applied to the second string 
event. While we could repeat the settings manually, it’s probably eas-
iest to copy the faded event:

7. Remove the second string event by clicking it with the Eraser tool.

8. Select the Arrow tool again, press [Alt]/[Option] and drag the first 
string event two bars to the right.
As you can see, the copied event retains the fade you created.

That concludes this tutorial! 

Now you’ve tried some of the many editing features in Nuendo’s Project 
window. If you like, you could use your new skills to change the end of 
the eight-bar “song”, which ends rather abruptly now. For example, you 
could apply fade-outs, resize events to make the different instruments 
end one by one, or create more copies to make the song longer. Or, 
you can move on to the next chapter, in which we’ll take a look at VST 
Instruments.
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About this tutorial

This tutorial shows you how to set up and use VST Instruments – soft-
ware synthesizers (or other sound sources) that are contained within 
Nuendo. For detailed descriptions of procedures and the parameters 
of the included VST Instruments, see the Operation Manual.

Preparations

Just like the previous chapter, this tutorial is based on an existing file, 
included on the Nuendo CD.

• Below, we assume that you have followed the previous tutorials and 
copied the “Nuendo Tutorial” folder to your hard drive.
If not, please see page 98.

1. Close any open projects, by making their Project windows active and 
selecting “Close” from the File menu.
This is just to make things clear and avoid confusion – you can have several projects 
open in Nuendo if needed.

2. Pull down the File menu and select Open.

3. In the file dialog that appears, navigate to the “Nuendo Tutorial” folder 
on your hard drive, select the file “Tutorial 6.npr” and click Open.

• At this point, a dialog may appear asking you to resolve missing MIDI 
outputs.
This is because you probably don’t have the same MIDI output configuration as the 
creator of this project. Just click OK to close this dialog for now.
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The “Tutorial 6” project opens. If you followed the previous tutorial, 
this will look oddly familiar… It’s the same eight-bar “song” that you 
created in tutorial 5, but with three extra tracks.

Activating a VST Instrument

The three tracks at the bottom of the Track list are MIDI tracks, as indi-
cated by the yellow border to the left in the Track list. As you can see, 
one of the tracks is called “MIDI Bass” – our first goal in this tutorial is 
to replace the “Bass” audio track with a bass sound from a VST Instru-
ment.

1. Pull down the Devices menu and select VST Instruments.
The “rack” that appears can contain up to 64 VST Instruments. However, the maximum 
number of instruments possible to use simultaneously depends on your computer per-
formance and the complexity of the instruments.
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2. Click in the first VST Instrument slot.
A pop-up menu appears, listing the included VST Instruments.

3. Select “vb-1” from the Synths submenu.
The VB-1 virtual bass unit is loaded, and its control panel appears.

4. In the control panel, make sure the “power button” in the top left cor-
ner is activated (lit).
There is a mirror of this power button in the VST Instrument slot.

5. You can keep the control panel open or close it – it doesn’t matter, as 
long as the VST Instrument is activated (power button is lit).
Since we cannot hear the instrument yet, there’s not much point in making any control 
panel settings though. If you close the control panel for the instrument, you can click 
the Edit (“e”) button in the slot to bring it up again.

OK, so now we have activated a VST Instrument. Now you need to 
route a MIDI track to the instrument.
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Routing

1. Go back to the Project window and select the “MIDI Bass” track by 
clicking in the Track list.

2. Make sure the Inspector is open.
The Inspector is the area to the left of the Track list. If it’s not visible, click the Show 
Inspector button on the toolbar:

3. Make sure the top section of the Inspector is shown.
If not, click on the button in the upper right corner of the Inspector:

The Inspector shows the settings for the selected track – in this case, 
the MIDI Bass track.

4. Pull down the “out:” pop-up menu in the Inspector.
This shows all available MIDI outputs, including any MIDI interfaces you have installed, 
any audio card-based synthesizers in your computer and all loaded VST Instruments.

5. Select the VB-1 from the pop-up menu.
The track is now routed to the VB-1. This VST Instrument receives MIDI on any channel, 
so you don’t have to care about the MIDI channel setting. However, some VST Instru-
ments are multitimbral and can receive different MIDI data on several different channels 
– if that had been the case you would have had to set the “chn:” setting properly.
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Playing back

Now it’s time to replace the audio bass with the VB-1:

1. Click the Mute (“M”) button in the Track list for the “Bass” track.
This mutes (silences) the track.

2. Click the lit Mute button in the Track list for the “MIDI Bass” track so 
that it goes dark.
You have now unmuted the MIDI Bass track.

3. Start playback from the beginning of the song.

You should now hear the VB-1 play the bass line. You may have to ad-
just the volume so that the VST Instrument matches the audio tracks:

4. Pull down the Devices menu and select Mixer.
The Mixer window appears. As you can see, there are separate mixer channel strips for 
the four audio tracks, the three MIDI tracks and the VB-1.

A mixer channel strip for a VST Instrument is indicated by a green field below the 
fader panel.

5. Use the volume fader in the VB-1 channel strip to adjust the level of 
the bass line.



NUENDO
Tutorial 6: Using VST Instruments 11 – 147

Adding another instrument

The next MIDI track is called “MIDI Perc” and contains a MIDI percus-
sion pattern. This is an excellent opportunity to check out another of 
the included VST Instruments – the LM-7 drum machine:

1. Open the VST Instruments window from the Devices menu.

2. Pull down the pop-up menu for the next slot and select “lm-7” from the 
Drums submenu.
Make sure its power button is activated.

3. In the Project window, click the Mute (“M”) button for the MIDI Perc 
track so that it goes dark.

4. Select the track by clicking in the Track list.

5. Use the “out:” pop-up menu in the Inspector to route the track to the 
LM-7.
As soon as you activate a new VST Instrument, it is added to the list of available MIDI 
outputs in Nuendo.

Now, let’s listen to the percussion track all by itself:

6. Click the Solo (“S”) button in the Track list for the MIDI Perc track.
All other tracks are muted (their Mute buttons light up).
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7. Start playback.

Hmmm, nothing can be heard – but the indicator in the Track list shows 
that MIDI notes are being played! The problem here is that the wrong 
program (drum set) is selected for the LM-7. For this track to play back 
properly, we should choose a percussion set. This can be done directly 
in the Inspector or the VST Instruments window, but let’s check out the 
control panel for the LM-7 instead:

8. Click the Instruments Settings button for the track in the Inspector 
(next to the “chn:” pop-up).
Since the track is routed to a VST Instrument, this opens the control panel for the in-
strument. This way, you don’t have to go via the VST Instruments window to make set-
tings for a VST Instrument.

The LM-7 panel. The labels underneath the buttons show the available sounds in 
the selected program – not many percussion sounds here.

9. Pull down the program pop-up menu in the control panel and select 
“Percussion”.
Under Windows, you will find this pop-up menu at the top of the panel; on a Mac it is 
at the bottom of the panel.

10.Start playback again.
That’s more like it.
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11.Go back to the Project window and click the lit Solo button for the 
track to turn off the Solo function.
All tracks are unmuted again – except the tracks that were muted from the beginning 
(Bass and MIDI Strings).

Again, you may want to adjust the volume of the LM-7. If you open the 
mixer, you will find that a new channel strip has appeared – use the 
fader as before.

Playing a VST Instrument in real time

The next part of this tutorial requires two things:

• That you have a MIDI keyboard or similar connected to a MIDI input on 
your MIDI interface.

• That you are using audio hardware with fairly low latency (see page 55).
If the latency is too high, it will be almost pointless to try to play a VST Instrument in 
real time – the delay between when you press a key and when you hear the sound will 
be too large. If you’re uncertain about your latency, just proceed with the steps below 
– you’ll find out whether it’s OK or not.

Now we’ll make use of the third included VST Instrument: the a1 syn-
thesizer. Here, we will use it with a string sound (replacing the “Strings” 
audio track) but you can of course choose another sound if you like.

1. Open the VST Instruments window from the Devices menu.

2. Pull down the pop-up menu for the third VST Instrument slot and select 
“a1” from the Synths submenu.
Make sure its power button is activated.

3. In the Project window, mute the “Strings” track and unmute the “MIDI 
Strings” track, by clicking their respective Mute buttons in the Track list.

4. Select the MIDI Strings track.

5. In the Inspector, pull down the “out:” pop-up menu and select “a1”.
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This routes the track to the a1 synthesizer. However, now we also 
need a MIDI input, since you’re going to play the VST instrument “live”:

6. Pull down the “in:” pop-up menu and make sure the correct MIDI input 
is selected.
This should be the MIDI input to which your keyboard (or other controller) is connected. 
If in doubt, you can select the “All MIDI Inputs” option, in which case the track will ac-
cept MIDI from all available inputs.

7. Click the monitor button in the Track list for the MIDI Strings track, so 
that it lights up.
When the monitor button is activated, incoming MIDI is sent directly to the selected 
output – in this case the a1 synthesizer.

8. Try playing your MIDI keyboard.
You should hear the sound from the a1. However, you may not want to use the default, 
first sound:

9. Use the pop-up menu below the “chn:” setting in the Inspector to 
select a suitable synth sound.
Since we’re supposed to replace the Strings part, you may for example want to try the 
“Solina WMF” patch (under the PAD heading).

10.Start playback and play along!
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Recording

When you’ve figured out something to play, it’s time to record this. Re-
cording for a VST Instrument is done just like “normal” MIDI recording:

1. Click the record enable button for the MIDI Strings track.

In previous tutorials we recorded from the project cursor position – 
now we will start recording at the left locator, with a precount.

2. Pull down the Transport menu and make sure the “Start Record at 
Left Locator” setting is activated.

3. Move the left locator to where you want the recording to start.
You can drag the locator flag in the ruler, edit the position numerically in the Transport 
panel or press [Ctrl]/[Command] and click in the ruler.

4. Move the right locator to a position to the right of the left locator.
This can be done by pressing [Alt]/[Option] and clicking in the ruler.

5. Activate Precount on the Transport panel.

6. Click the Record button on the Transport panel to start recording.
You will hear a two bar count-in and then the recording will start.

7. Play along with the background tracks.
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8. When you’re done, click Stop.
A MIDI part has been created on the MIDI Strings track.

9. Play back to listen to your recording.
If you want to try again, select Undo from the Edit menu and proceed from step 3 above.

10.When you’re done, click the record enable button for the track to de-
activate it.

Making parameter settings

After you’ve recorded your synth or string part (and possibly adjusted 
its volume in the mixer) you may want to adjust the actual sound as well. 
This can either be done by selecting another patch in the Inspector or 
VST Instruments window, or by using the synth parameters in the con-
trol panel for the a1.
First, you may want to set things up so that the whole piece plays back 
over and over again.

1. In the Project window, press [Ctrl]/[Command]-[A] to select all events 
and parts.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left locator to the start of the first event and the right locator to the end 
of the last.
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3. Make sure Cycle is activated on the Transport panel, and start playback.
The whole “song” will now play back repeatedly.

Cycle activated on the Transport panel.

4. Click the Instruments Settings button in the Inspector (to the left of 
the “chn:” pop-up) for the MIDI Strings track, to bring up the a1 con-
trol panel.

5. While the music is playing, try adjusting the parameters by clicking 
and dragging the controls in the panel.
The a1 is laid out much like a traditional analog synthesizer. You may for example want 
to adjust the Cutoff and Resonance settings in the Filter section.
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Automating the changes

Just like other mixer and effect settings in Nuendo, parameter changes 
for VST Instruments can be automated. Proceed as follows:

1. Stop playback and move the project cursor to the start of the project.

2. Turn off the Cycle button on the Transport panel.
This is simply a “safety measure” – if you record automation in Cycle mode, you may 
accidentally overwrite parameter changes you have made on a previous Cycle lap.

3. Click the Write (“W”) button in the a1 control panel.

4. Start playback.

5. Adjust the parameters you want – create filter sweeps, add modula-
tions, etc.

6. When you’re done, click Stop.

7. Deactivate the Write (“W”) button in the a1 control panel.

8. Click the Read (“R”) button next to it.
This makes the VST Instrument “read” the recorded automation during playback.

9. Start playback from the beginning of the project.
You will now see the controls moving, replicating your recorded parameter adjustments.

That concludes the VST Instrument tutorial! If you’re satisfied with 
what you recorded, you may want to save the project by selecting 
Save from the File menu.
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About this tutorial

This chapter describes the basic procedures for editing audio in the 
Sample Editor and how to use the Process functions. For a full descrip-
tion of all settings, options and operations available, please refer to the 
chapters “The Sample Editor” and “Audio Processing and Functions” 
in the Operation Manual.

The Sample Editor

The Sample Editor allows you to edit audio, by cutting and pasting, re-
moving, drawing or processing audio data. This editing can be called 
“non-destructive”, in the sense that you can undo changes or revert to 
the original versions at any point, using the Offline Process History 
(see page 161).

What is shown in the Sample Editor?

An audio event plays a section of an audio clip, see page 196. When 
you open the Sample Editor for an audio event, it will display the wave-
form image of the corresponding audio clip. Above the waveform dis-
play is the thumbnail display, which provides an overview of the whole 
clip, with a blue rectangle corresponding to the section currently shown 
in the waveform display. You can navigate by dragging or resizing the 
blue rectangle in the thumbnail display.
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Editing audio in the Sample Editor – an example

This example describes how to remove a section of audio and insert it 
at another position, by using cut and paste in the Sample Editor:

1. Open the Sample Editor by double clicking an audio event in the 
Project window.

2. Select the Range Selection tool by clicking its icon on the toolbar.

3. To select a section of the clip, click and drag in the waveform display.

Click at the position where you wish the selection to begin, and drag...

...to make a selection range.
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4. Release the mouse button when the selection is complete.
You can adjust the selection by dragging its edges.

5. Select “Cut” from the Edit menu.
The selection is removed from the clip and moved to the clipboard. The section to the 
right of the selection is moved to the left to fill out the gap.

Selecting “Paste” from the Edit menu will copy the data on the clip-
board into the clip according to the following rules:

• If there is a selection in the editor, the pasted data will replace it. 
• If there is no selection (if the selection length is “0”), the pasted data will be in-

serted starting at the selection line.
By clicking, you can place the selection line at any position in the event. The section to 
the right of the line will be moved to make room for the pasted material.

6. For this example, make the end of the event visible, either by using the 
scrollbar or by moving the blue rectangle in the thumbnail display, and 
click to place the selection line at the event end position.

7. Now select “Paste” from the Edit menu.
The selection that was cut is inserted at the position of the selection line.
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Processing audio

The Process submenu on the Audio menu contains a number of audio 
processing functions. The functions can be applied to selected audio 
events or clips, or to a selected range. 

In this example, we will apply normalizing to a selected audio event. 
The Normalize function allows you to specify the desired maximum 
level of the audio. A common use for normalizing is to raise the level of 
audio that was recorded at too low an input level.

Proceed as follows:

1. Select an audio event by clicking on it with the Arrow tool in the 
Project window.

2. Pull down the Audio menu and select Process.
A submenu opens, containing all processing functions available.

3. Select “Normalize” from the submenu.
The Normalize dialog opens. 

4. For this example, use the default “Maximum” setting of 0.00 dB.

• You can use the “Preview” button to listen to the result of the process-
ing if you wish.
The processing will not be applied, just auditioned.

5. Click “Process” to apply the processing.
The audio event is normalized. 
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Applying an effect plug-in

As described on page 107, you can add “real-time” effects in the 
mixer. However, sometimes it is useful to apply an effect directly to an 
audio event or clip. This is done using the Plug-ins submenu on the 
Audio menu:

1. Select an audio event in the Project window.
In this example, we select the event that was normalized in the previous example.

2. Pull down the Audio menu and select Plug-ins.
A submenu appears, listing the installed effect plug-in folders. The effects are orga-
nized in these subfolders according to the effect category.

3. Select the “Flanger” effect from the Modulation subfolder.
The Flanger dialog appears.

4. Use the parameters in the upper part of the dialog to set up the effect 
as desired.
Clicking the Preview button will let you audition the settings before actually applying 
the effect.

5. Click the “Process” button to apply the effect.
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Using the Offline Process History dialog

The Offline Process History dialog allows you to remove or modify au-
dio processing at any time. It is even possible to modify or remove some 
processing “in the middle” of the Process History, while keeping later 
processing! Whether this can be done or not depends on the type of 
processing performed, as described in the chapter “Audio Processing 
and Functions” in the Operation Manual.

In this example, we will remove the Normalize function, but keep the 
applied Flanger effect:

1. Select the audio event in the Project window.

2. Pull down the Audio menu and select “Offline Process History…”.
The Offline Process History dialog appears. This contains a list of the processing func-
tions applied to the audio clip, with the most recent operation at the bottom of the list.

3. Select the “Normalize” action by clicking in the list.

4. Click the “Remove” button.
You are asked whether you really want to remove the processing.

5. Click “Remove”.
The Normalize processing is removed, but the Flanger effect is kept.
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Batch processing

The Offline Process History dialog has an additional use. A list of ap-
plied processing functions in this dialog, modified or unmodified, can 
be saved as a batch process for future use. Batch processing is a 
convenient function for applying a chain of audio processing to any 
number of audio events, and process them all in one go.

How to set up and execute batch processes is described in the chap-
ter “Audio Processing and Functions” in the Operation Manual.



13
Tutorial 8: Editing MIDI



NUENDO
13 – 164 Tutorial 8: Editing MIDI

About this tutorial

This chapter describes the basic operations for editing MIDI in the Key 
Editor. For a full description of MIDI editing please refer to the chapter 
“The MIDI Editors” in the Operation Manual.

This chapter assumes that you have read the instructions in the chap-
ter “Recording and playing back MIDI”, and have access to a recorded 
MIDI part.

Opening the Key Editor

By default, you open the Key Editor by double clicking a MIDI part in 
the Project window.

The Key Editor window shows the contents of one or several parts. You can have 
several editors open at the same time.

• The note display is the main area in the Key Editor. It contains a grid, in which 
MIDI notes are shown as boxes.
The width of a box corresponds to the note length, and the vertical position of a box 
corresponds to the note number (pitch), with higher notes higher up in the grid. 

• The piano keyboard to the left serves as a guide for finding the right notes.

• The area at the bottom of the Key Editor window is the controller display, used 
for viewing and editing velocity, MIDI controllers, etc. (see page 169).
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Drawing events in the Key Editor

When you move the pointer in the note display, its bar position is indi-
cated in the toolbar, and its pitch is indicated both in the toolbar and 
on the piano keyboard to the left. This makes it easy to find the right 
note and insert position.

To insert new notes in the Key Editor, proceed as follows:

1. Select the Pencil tool.

2. Click at the desired time position and pitch (height).

A note is inserted with the following additional properties:

• If you just click once, the created note will get the length set on the 
“length Q” pop-up menu on the toolbar.
You can create a longer note by clicking and dragging the pointer to the right with the 
mouse button pressed. The length of the created note will be a multiple of the Length 
Quantize value.

• The notes will get the insert velocity value set on the toolbar.
Velocity values are viewed and edited in the controller display, see page 169.
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About Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when editing in the 
Key Editor. It does this by restricting horizontal movement and posi-
tioning to certain positions. Operations affected by snap include mov-
ing, duplicating, drawing, sizing, etc.

• When the “Bars+Beats” display format is selected in the ruler, the 
quantize value on the toolbar determines the snap value.

• When any time-based display format is selected in the ruler, editing 
snaps to the visible grid.

Selecting and moving events

To select events in the Key Editor window, proceed as follows:

1. Make sure the Arrow tool is selected.
If not, click on the Arrow icon in the toolbar.

2. To select a single event, click on it.
To select several events, use [Shift]-clicking or click and drag a selection rectangle.

To move events in the Key Editor window, proceed as follows:

1. If you want to move more than one event, select them as described 
above.
If you want to move a single event, you don’t need to select it.

2. Click on one of the events with the Arrow tool and drag it to the de-
sired position.
If Snap is activated on the toolbar, this determines the exact position of the moved 
events.
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About quantize

Quantizing in its fundamental form is a function that automatically 
moves recorded notes, positioning them on exact note values.

• Quantizing affects MIDI notes only (not other event types).
• In the Project window, quantizing applies to all selected parts, affecting all 

notes within them.
• In the Key Editor, quantizing applies to all selected notes. If no notes are se-

lected, all notes will be affected.

Here follows a simple step by step example of using the quantize 
function:

1. Let’s say you have recorded a series of eighth notes, which you have 
opened for viewing in the Key Editor.
As shown in the illustration below some of them have ended up slightly beside the ex-
act eighth note positions.

Now there are two basic ways you can proceed:

• To quantize all notes, no notes need to be selected.

• To quantize only several notes, select them.
Only the selected notes will be quantized.

In this example, we have chosen to leave all note events unselected.
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2. Open the quantize pop-up menu on the toolbar.
The menu contains three main categories of note values, Straight, Triplet and Dotted.

3. For this example, select straight 1/8 Note quantize from the menu.

4. Select “Over Quantize” from the MIDI menu.
This quantizes the MIDI notes according to the Quantize pop-up menu setting.

Straight note values

Triplet note values

Dotted note values
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Editing velocity in the controller display

The Key Editor controller display is used for viewing and editing vari-
ous values and events. The controller display can have one or several 
lanes, each showing a separate event type.

• If no controller display is shown, right-click (Windows) or [Ctrl]-click 
(Mac) anywhere in the editor window and select “Create New Controller 
Lane” from the pop-up menu that appears.
This displays the controller display at the bottom of the Key Editor window.

• If you click the arrow to the left of the controller display, a pop-up ap-
pears allowing you to select what event type you wish to view.
For this example, select “Velocity”.

• When “Velocity” is selected for viewing, the controller display shows 
the velocity of each note as a vertical bar.

Velocity events in the controller display.

• To change the velocity of a single note, click on its velocity bar with 
the Pencil tool, and drag the bar up or down. If there are several notes 
on the same position only the velocity value of the selected note is 
changed. If there is no note selected the velocity values for all notes 
on this position will be changed.
While you drag, the current velocity value is shown in the display to the left.

• To change the velocity values of several notes, you can either draw a 
“velocity curve” with the Pencil tool or use the Line tool to create a ve-
locity ramp.
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An example

In the following example we will create a velocity ramp using the Line 
tool:

1. Add some notes in the note display by using the Pencil tool.

2. Select the Line tool from the pop-up menu that appears by clicking on 
the Pencil tool icon.
The other tools available on this pop-up menu are described in the Operation Manual.

3. Click where you want the ramp to start, move the pointer to where you 
want the ramp to end and release the mouse button.
When the mouse button is released, the velocity values will be scaled according to the 
ramp curve.
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About this tutorial

This chapter describes how you can set up and customize Nuendo in 
various ways according to your personal preferences.

Practically everything in Nuendo can be customized to your liking: Key 
Commands can be freely changed and assigned to functions, items can 
be hidden in the toolbars, Track list and the Transport panel, menu items 
and entire menus can be hidden from view etc. In Nuendo you can 
change the entire look of the program using appearances, if you wish.

This tutorial deals with adapting your work environment to what you 
need to do and how you want to do it. We will assume that you don’t 
need to use MIDI at all and therefore want to hide all MIDI related 
functions. Furthermore, we will describe how to set up preferences, 
key commands, window layouts etc. and create a template.

This will show you some of all the ways in which Nuendo can be tai-
lored to best suit your needs and purposes. However, you should also 
read the chapter “Customizing” in the Operation Manual since many 
available options and settings are not described in this chapter.
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Hiding menu items

Separate menu items and even entire menus can be hidden from view 
in Nuendo. Since we’ve decided we don’t need any MIDI functions, 
let’s start by hiding the entire MIDI menu:

1. Pull down the File menu and select “Preferences...”.
The Preferences dialog opens.

2. In the left column, select “Configuration”.
The Configuration page in the right column contains a hierarchical view of folders, sim-
ilar to the one in the Windows Explorer or the MacOS Finder. There are two main fold-
ers – “Main Menu” and “Command Categories”, which contain subfolders for all main 
menu items and Key Command categories respectively.

3. Locate the subfolder “MIDI” in the main folder “Main Menu”.
This subfolder corresponds to the MIDI menu in Nuendo. If you click the “+” button to 
the left of the subfolder, it opens to reveal all the items on the MIDI menu.

4. To hide the entire MIDI menu in Nuendo, click in the Menu column to 
the right of the “MIDI” subfolder.
The text “On” in the column now changes to “Off” – indicating that the menu won’t be 
shown.
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5. Click Apply to apply your changes without closing the dialog.
The MIDI menu is hidden in the main menu bar.

There is another column to the right, labeled “Comm”. This deter-
mines whether it should be possible to use key commands for the 
menu items (which can be possible even if the menu items are hidden 
from view). In this case we don’t want to use the MIDI features at all, 
so let’s turn off their key command functionality as well:

6. Click in the Comm column for the “MIDI” subfolder to set it to “Off”.

Now we’ve hidden the entire MIDI menu. You can also hide individual 
menu items in the same way:

7. Click the “+” button to the left of the “File” subfolder.
The File subfolder opens, revealing all items on the File menu. As you can see, the File 
subfolder in turn contains a few other subfolders, among them one called “Import”. 
This corresponds to the Import submenu on the File menu.

8. Click the “+” button to the left of the Import subfolder.

9. In the list of menu items in the Import subfolder, locate the item “MIDI 
File...”.
Since we don’t need to be able to import MIDI files into Nuendo, we can hide this.

10.Hide this from view and disable it by setting the Menu and Comm col-
umns to “Off”.
The “Import MIDI File” menu item will now be hidden and you won’t be able to access 
it with a key command.

In this way, you can proceed to hide any and all menu items you don’t 
need.
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Setting preferences

While we’re in the Preferences dialog, we might as well make a few 
other settings so that the program behaves the way we want it to:

1. In the left column, select the “Editing” item.
The editing page to the right contains a number of options for how the program should 
behave.

2. Activate the option “Auto Select Events under Cursor” by clicking in 
its box to put a checkmark in it.
When this option is activated, all events “touched” by the project cursor are automati-
cally selected. This can be helpful when rearranging projects, since it allows you to se-
lect whole sections (on all tracks) simply by moving the project cursor.

Now, let’s activate another useful option. If you are usually working on 
single projects for long periods of time (i.e. more than one “session” 
with the program), you might want to have that project automatically 
open when you launch Nuendo:

3. In the left column of the dialog, select the item “General”.
The General settings page appears to the right. Among other things on this page, you 
can see an item called “On Startup”. This is a pop-up menu that allows you to specify 
what should happen each time you launch Nuendo.

4. Pull down the “On Startup” pop-up menu and select the option “Open 
Last Project”.
Now, you have instructed Nuendo to open the last saved project each time you launch 
the program.
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Using presets

OK, so now we have set up some menus and preferences to our liking. 
By clicking Apply or OK, the changes you have made will be saved glo-
bally for all projects you work on.

But what if a single project comes along when you need to use MIDI? 
You could of course go back and change the settings again, do the 
MIDI project and then change the settings once again. An easier way 
is to store the settings you’ve made as a preset. That way you can 
make momentary changes (or click the Defaults button to reset all 
preferences to default values), do the MIDI project and then simply re-
call your stored preset with all your settings.

In the bottom left of the Preferences dialog, there is a Preference Pre-
sets menu, three buttons labeled “Store”, “Rename” and “Delete” and 
a checkbox named “Store marked preferences only”.

To store the current settings as a preset, proceed as follows:

1. First, make sure that the “Store marked preferences only” box is not 
checked.
This option is for saving partial preferences settings only. So the reason you should 
leave it unchecked is because we want to save all the preferences in this example.

2. Next, click the “Store” button.
A dialog now appears, allowing you to name the preset.

3. Type in a name of your choice and click OK.
You might want to give the preset a descriptive name, identifying its purpose, like for 
example “No MIDI”. 

The settings are now stored as a preset with the name you specified, 
and will be available for quick recall. This is done by loading a preset, 
which is what we will do next.
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Loading a preset

1. Select the “General” page and activate the option “Auto Save”.
This is just for the sake of example.

2. Pull down the Preference Presets pop-up menu.
The preset you previously saved is now available on the menu.

3. Select the stored preset from the menu.
The Preferences settings contained in the preset are now applied. As you can see, the 
option “Auto Save” is deactivated again, since it was turned off in your preset.

Our work in the Preferences dialog is now done – click OK in the bot-
tom right area to exit the Preferences dialog and apply the settings.
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Setting up Key Commands

Next, we will set up some key commands. Key commands are short-
cuts for menu items and functions, meaning you can invoke an item or 
a function just by pressing a key or a combination of keys on your key-
board. Key commands can be customized any way you like, so if you 
use a particular function very often for example, you can assign a key 
command for it. Or if it already has a key command assigned to it by 
default, you can change it to one that suits you better.

• For a list of the default key commands in Nuendo, see page 219.

Let’s say that you often use the “Audio File” command from the Import 
submenu, and want to assign a key command for it:

1. From the File menu, select “Key Commands…”.
The Key Commands dialog opens. In the left part of this dialog, all main menu items 
and a large number of other functions are arranged in a list of different categories, dis-
played as folders. Each category folder in turn contains a number of commands – 
menu items and functions.

2. Since we want to assign a key command for the “Audio File” command 
from the Import submenu, and we know that menu item is located on 
the File menu, navigate to the folder called “File”.

3. Click the “+” button to the left of the folder to open it.
You can now see a list of items and functions it contains.
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4. In the list, select the item “Import Audio File”.
As you can see, this function has no key command assigned to it, as indicated by the 
empty “Keys” column and the “Keys” section in the top right corner.

Now, how do we know which key command we can use – that is, find 
a key command that isn’t already used for some other function? 
Here’s how to find out:

5. Click in the “Type in Key” field to the right.
There is now a flashing cursor in the field, indicating that you can type in it.

6. Let’s try [A], by pressing the A-key.
No luck. As you can see by the text that appears under the field, the A-key is already 
assigned to the function “Adjust Fades to Range”.

7. OK, then let’s try a combination – how about [Shift]-[A]?
Success! Since no text appears under the text field, that key command is not assigned 
to any function. Now we can proceed to assign that particular key command to the “Im-
port Audio File” function.

8. Again, make sure “Import Audio File” is selected in the list to the left.

9. Now, click the “Assign” button above the text field.
The key command Shift+A appears in the Keys section.

We have now set up a key command that will be available in the pro-
gram after we close the Key Commands dialog.

However, we’re not quite done here yet so don’t close the dialog.
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Setting up a Macro

We will also try setting up a key commands Macro. A Macro is a 
stored combination of several functions or commands. By invoking the 
Macro you can perform these functions and commands in one go, 
rather than manually performing them one at a time.

In this example, we’ll create a Macro that will: 

• Select all events in the project window
• Position the left and right locator to encompass the selection. 

This is done by combining the commands “Select All” from the Edit 
menu and the command “Locators to Selection” from the Transport 
menu:

1. In the Key Commands dialog, click the “Show Macros” button in the 
lower part of the dialog.
The Macro settings are now revealed in the lower part of the dialog and the Show 
Macros button is renamed Hide Macros, indicating that you can close the Macros sec-
tion by clicking the button again.

2. Click the button “New Macro”.
A new, unnamed Macro appears in the Macros list to the left. Name it by typing in the 
desired name.

Now, we need to select the first command that should be executed in 
the Macro – namely the “Select All” command:

3. Since we know the “Select All” command is located on the Edit menu, 
open the Edit folder in the Commands list, navigate to the item “Select 
All” and click on it to select it.

4. Click on the “Add Command” button in the Macros section.
As you can see, the “Select All” command is added to the Macro in the Macros list.
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5. Now repeat this procedure to select the item “Locators to Selection” 
from the Transport folder and add it to the Macro.

That’s it, we have now created a Macro with two commands. The Macro 
will be available for instant selection and execution on the Macros sub-
menu at the bottom of the Edit menu in the program.

If you like, you could also assign a key command to the Macro, by se-
lecting the Macro in the Commands list and assigning a key command 
to it as described above. We will not do that now, however. What we 
will do is to save the key commands settings we have made, including 
the macro settings, as a preset for instant recall later.

Storing key commands as presets

By storing our key commands settings as a preset, it will be possible 
to recall them later – useful if you will be making temporary settings to 
the changes or if you want to move your settings to another computer:

1. Make sure that the “Store Selected Items Only” box is not checked.
This option is for storing partial key commands setting – we want to store them all.

2. Click the Store button (the disk icon) next to the Presets pop-up menu.
A dialog appears, allowing you to type in a name for the preset. 

3. Type in a name and click OK to save the preset.
These key commands settings are now saved and will be available on the Presets pop-
up menu. To recall these settings in the future, all we have to do is to select them from 
the Presets pop-up menu.

• It’s also possible to store “Alternative Key Sets” – this allows you to 
change between different key command setups on the fly while you 
are working in the program.
See the Operation Manual for details.

With that, our work in the Key Commands dialog is done, so you can 
close it and apply the changes by clicking OK.
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Changing the look of the Transport panel

In Nuendo you can change the contents and look of several sections 
and panels, including the Transport panel, toolbars in the Project win-
dow and the editors, and the track controls in the Track list. The 
changes you can make include hiding unwanted controls and settings 
from view and reordering items on the panels.

Below we will try customizing the Transport panel. According to the 
previous sections, the intention is to hide everything MIDI-related. We 
will also try changing the positions of sections on the panel.

1. If the Transport panel isn’t in view, select it from the Transport menu 
(or use the key command for this – [F2] by default).
As you can see, in addition to the play controls, the Transport panel hosts a number of 
other controls and indicators. To the right of the Marker section is a MIDI activity meter 
which indicates incoming and outgoing MIDI signals. Since we don’t work with MIDI, 
we might as well hide this from view entirely:

2. Right-click (Windows) or [Ctrl]-click (MacOS X) anywhere on the 
Transport panel.
A pop-up menu appears. The upper half of the menu lists all the elements that can be 
shown or hidden in the Transport panel.

3. On the menu, deactivate the item “MIDI Activity”.
A checkmark next to an element means it is visible in the Transport panel. As you can 
see, the menu closes and the MIDI activity meter is now hidden.

4. Bring up the pop-up menu again.
The items on the lower half of the menu are presets, allowing you to quickly select e.g. 
a Transport panel with transport buttons only. It’s also possible to store your own pre-
sets, for instant recall:

5. Select “Setup...” from the pop-up menu.
A dialog opens.

The MIDI activity meter
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In this dialog you can decide which elements should be shown and 
hidden, by selecting them and moving them from column to column 
using the arrow buttons. The left column displays the currently visible 
items, and the right column the currently hidden items on the Trans-
port panel. As you can see, the right column contains the MIDI Activity 
meter, since we’ve already hidden that from view.

You can also configure the layout of the Transport panel here, by mov-
ing elements with the Move Up and Move Down buttons. Let’s try 
moving the Jog/Scrub wheel to the left on the Transport panel:

6. Click the Jog/Scrub item to select it in the list.

7. Click the Move Up button.
The Jog/Scrub item is moved up in the list and to the left on the Transport panel. It now 
appears to the left of the Locators section.

Let’s store this setup as a preset:

8. Click the disk button by the Presets pop-up menu.
A text field appears, allowing you to name the current configuration.

9. Type in a name and click OK.
The saved preset appears in the Presets field. You can now select this saved configu-
ration anytime from the Presets pop-up menu in this dialog, or directly from the pop-up 
menu brought up by right-clicking or [Ctrl]-clicking the Transport Panel.

• You can customize toolbars and the Track list in much the same way.
Read more about this in the Operation Manual.

We’re done here, so close the dialog and let’s move on.
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Creating a template

If you often work with the same types of Projects, it might be a good 
idea to set up a track layout and then save it as a template. That way, 
you can select the saved template from the New Project dialog each 
time you create a new project, and start with your preferred layout and 
settings.

Let’s say for example that you work with movie post production 
projects a lot and want to create a template with a convenient track 
layout. You could set things up as follows:

Start by creating a new, empty project:

1. Select New Project from the File menu.
It doesn’t matter which Project folder you select.

2. Pull down the Project menu and select “Project Setup…”.
The Project Setup dialog appears.

3. Make settings according to your needs and click OK.
The settings here include sample rate, record format (resolution), display format, frame 
rate, etc.

You should also set up the required input and output busses. Let’s 
say you are working with surround sound in 7.1 format:

4. Open the VST Connections window from the Devices menu.

5. Select the Outputs tab and click the Add Bus button.
A dialog appears.

6. Select the desired 7.1 format from the Configuration pop-up (“More...” 
submenu) and click OK.

7. Use the ASIO Device Port column to select audio outputs on your 
audio hardware for the different speaker channels.

8. If needed, click the Inputs tab and set up input busses in the same way.

9. Close the VST Connections window.

Now you need audio tracks for the soundtrack. Since you work with 
7.1 surround soundtracks, let’s create eight mono audio tracks:
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1. Right-click (Windows) or [Ctrl]-click (Mac) anywhere in the Track list, 
and select “Add Multiple Tracks…” from the pop-up menu that appears.
A dialog appears, allowing you to specify the type of tracks, the track configuration and 
the number of tracks.

2. Pull down the respective pop-up menus in the dialog and select the 
desired options.
Type should be Audio of course. In this example we’ll use mono tracks, so select that. 
Finally, enter 8 in the Count menu. You can do this either by typing in the number 
directly or by using the small up and down arrow buttons.

3. Click OK.
Eight audio tracks are now added to the project.

4. Open the mixer and use the Output pop-up menus to route each track 
to the corresponding speaker channel in the surround output bus.
See page 126.

The next thing to do is to add a video track. A convenient layout to use 
when working with video and multi-track audio is to place the video 
track in a separate, fixed Track list above the regular Track list. This 
makes it possible to scroll and zoom the Track list containing the au-
dio tracks without affecting the Track list containing the video track.

5. Click the “Divide Track List” button in the top right corner of the Track 
list.
The Track list is now divided into two parts. The lower part, as you can see, contains 
the audio tracks we added. The upper part is a separate fixed list. It is fixed in the 
sense that it is not affected by vertical scrolling and zooming in the lower Track list. It is 
however possible to resize tracks vertically by dragging the dividers in the track lists.

The Divide Track List button.

6. Next, pull down the Project menu, and from the Add Track submenu, 
select “Video”.
A video track is added, and as you can see, it is automatically added to the upper, fixed 
track list which is precisely what we want.
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• Should you need to move a track from the lower track list to the upper 
(or vice versa) you can do this by right-clicking (Windows) or [Ctrl]-
clicking (MacOS X) it in the track list and selecting “Toggle Lane”.

Now, let’s see, what else do we need for a movie post production 
project? We could use a Marker track and a Time Scale track, both of 
which should also be placed in the upper track list.

• Marker tracks can contain Markers, which can be used for locating and jump-
ing to certain positions.

• Time Scale tracks are additional rulers that show the timeline. A Time Scale 
track can show a different format than the main ruler. For the video track you 
might want to use a ruler that displays a film format, like Feet+Frames 35 mm 
while having another format in the main ruler, like Seconds.

7. To add these two tracks, follow the procedure described in step 6 
above, and select them in turn.

8. As you can see, they are automatically added to the upper, fixed track 
list which is again precisely what we want.

9. Now, we could resize the upper track list to “close any gaps” and 
make it just high enough to show the three tracks it contains.
Do this by clicking and dragging the divider between the track lists.

The last step in setting up the track list is to select the format for the 
Time Scale track:
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1. Click in the left part of the time scale track in the Track list, and from 
the pop-up menu that appears, select “Feet+Frames 35mm”.
This is a format that displays feet, frames and 1/4 frames, with 16 frames per foot.

This layout should make a useful movie post production template. 
There’s one final thing to do before we save it:

2. Position the windows the way you want them.
You may want to hide unwanted windows from view, position the Transport panel, max-
imize the Project window, etc. The open windows and their positions will be included 
in the template.

3. Finally pull down the File menu and select “Save as Template...”.
A dialog appears, asking you to name the template. This could be a descriptive name 
such as “Movie Post Production” for example.

• If you now select “New Project” from the File menu, your template will 
be listed in the dialog that appears.
Selecting it will create a new project with the track layout you’ve created.
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Setting up Zoom presets

When working in the Project window and the editors, you will typically 
need to zoom in and out depending on what you’re doing. In the project 
window, zooming can be done with the zoom sliders to the right, with 
the Zoom submenu on the Edit menu or with the magnification glass 
(see page 209 for more about zooming).

Zoom presets are a handy way to toggle between different zoom set-
tings. In this example we will set up a couple of presets: One that dis-
plays the whole project for a good overview, and one with a high zoom 
factor for detailed editing. We will continue working with the track lay-
out you set up for the template.

1. Locate the vertical zoom slider in the lower right corner of the project 
window.
Just above the slider is a small arrow button – this opens the vertical zoom menu.

2. Pull down the vertical zoom menu and select the option “Zoom Tracks 
Full”.
The project is zoomed vertically so that the eight tracks we added before take up the 
entire project window (or rather, the entire lower track list area). This way, we get a 
nice, compact layout.

Vertical zoom menu.

Horizontal zoom menu. Horizontal zoom slider.

Vertical zoom slider.
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3. Use the horizontal zoom slider to set a suitable horizontal zoom.
Check the rulers to see how much of the project will be visible at different zoom factors.

4. When you’re satisfied, pull down the horizontal zoom menu and select 
“Add”.
A dialog appears, allowing you to type in a name for the preset e.g. “Overview”.

5. Click OK to save the zoom preset.
This will now be available on the horizontal zoom menu, from which it can be selected 
and applied.

6. Use the vertical and horizontal zoom sliders to zoom in for a detailed 
view, and repeat the procedure of saving the zoomed factor as a preset.
We could name this “Detailed” for instance.

Now it will be possible to toggle between these two zoom factors sim-
ply by selecting the corresponding preset from the zoom menu.
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Creating window layouts

The final task in this tutorial will be to set up a couple of window lay-
outs. A window layout is a configuration of windows and their proper-
ties – their sizes and positions etc. This makes it possible to quickly 
switch between different working modes.

In the following example, we will create two window layouts: One for 
editing purposes, with the Project window and the Project Browser 
displayed, and one for mixing purposes, with the Mixer and the Project 
window displayed.

1. Let’s start by opening the Project Browser, which lets you view and 
edit events of a project in list form.
This is opened from the Project menu.

2. Now arrange the Project window and the Project Browser next to 
each other, so that they fill the whole screen but don’t overlap. 
If you are using Nuendo for Windows, you can quickly do this selecting “Tile Horizon-
tally” from the Window menu.

You will probably also want to move the Transport panel so that it 
doesn’t obscure the view.

OK, let’s save this view as a window layout then:

3. Pull down the Window menu again, and from the Window Layouts 
submenu select “New...”.
A dialog appears, allowing you to name the window layout.

4. Type in a name, e.g. “Editing” and click OK.

Now, we have created a window layout for editing purposes. The next 
step is to create a layout for mixing purposes:

5. Close the Project Browser window, and instead open the Mixer from 
the Devices menu.

6. Resize the Mixer and the Project window the way you want them and 
arrange the two windows as you see fit.

7. When you’re satisfied with the view, once again select “New...” from 
the Window Layouts menu and name the window layout.
“Mixing” could be a suitable name for instance.
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Now you can quickly switch between these two layouts:

8. Pull down the Window menu and display the Window Layouts sub-
menu.
Both layouts are listed at the bottom of the menu.

9. Select “Editing”.
The mixer is closed, the Project Browser is opened and the windows are instantly posi-
tioned in the way you stored them. It’s also possible to switch window layouts by using 
key commands.

That concludes this tutorial!
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About this chapter

This chapter describes the basic “building blocks” and terminology in 
Nuendo. Please take your time to read this chapter thoroughly before 
moving on!

The project

The native document format of Nuendo is called a project. Before you 
can start recording, playing back or editing you always have to create 
a new project, or open a saved project file from disk. There can be 
several projects open at the same time, but one is always the active 
project.

Two Project windows in Nuendo. In this picture, the project “on top” is the active 
project, as indicated by the lit blue indicator in the upper left corner of the window.
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About the file and folder structure
A project file (file extension “.npr” under Windows) is always associ-
ated with a project folder on your hard disk. Several projects can 
share the same project folder (which is practical if you have several 
versions of your project, for example).

• The Audio folder contains audio files referenced by the project.
It is also possible for the project to refer to audio files elsewhere on your disk(s) – you 
can even specify different folders for different audio tracks when recording. However, 
having all audio files in the project’s Audio folder makes the project easy to move and 
archive, and is a good safety measure.

• The Edits folder contains audio files created automatically by editing 
and processing operations in Nuendo.
As a rule, you shouldn’t touch the files in this folder. To remove unused edit files, it is 
better to use the Cleanup function, as described in the Operation Manual.

• The Images folder contains waveform images for the audio files in the 
project.

• The Network folder contains information and setting for Nuendo’s net-
working features.
This folder will appear if you have set up a network project – see the Networking pdf 
document.

• The project file itself contains all references to audio and video files, 
along with playback information, MIDI data and settings for the project 
(such as sample rate, frame rate, etc.).

• Video files are never automatically copied to the project folder.
This is because video files are often very large, and it doesn’t make sense to copy them 
into different project folders. However, nothing stops you from creating a Video folder 
inside the project folder and storing your video files there.

• You may also find additional files in the project folder.
For example, Nuendo’s Auto Save feature stores backup copies of the project file in its 
project folder.
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Audio terminology

When you record audio in Nuendo, this is what happens:

• An audio file is created on the hard disk.
• In Nuendo, an audio clip is created. The audio clip refers to the audio file on 

disk.
• An audio event is also created in Nuendo. This plays back the audio clip.

There are good reasons for this long chain of references:

• The audio event is the object that you place on a time position in Nuendo. If 
you make copies of an audio event and move them to different positions in the 
project, they will still all refer to the same audio clip. 
Furthermore, each audio event has an Offset value and a Length value. These 
determine at which positions in the clip the event will start and end, i.e. which 
section of the audio clip will be played back by the audio event. For example, 
if you resize the audio event, you will just change its start and/or end position 
in the audio clip – the clip itself will not be affected.

• The audio clip does not necessarily refer to just one original recorded file! 
For example, if you apply some processing to a section of an audio clip, this 
will actually create a new audio file that contains only the section in question. 
The processing will then be applied to the new audio file only, leaving the orig-
inal audio file unchanged. Finally, the audio clip is automatically adjusted, so 
that it refers both to the original file and to the new, processed file. During 
playback, the program will switch between the original file and the processed 
file at the correct positions. You will hear this as a single recording, with pro-
cessing applied to one section only.
This feature makes it possible to undo processing at a later stage, and to apply 
different processing to different audio clips that refer to the same original file.
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Audio tracks, parts and channels

For an audio event to be played back in Nuendo, it has to be placed on 
an audio track. This is similar to a track on a multi-track tape recorder, 
and allows you to view the event and move it along the timeline. You 
can place any number of audio events on an audio track, but only one 
at a time can be played back. You can have a virtually unlimited number 
of audio tracks, although the number of tracks you can play back at the 
same time depends on your computer performance.

Even though audio events can be placed directly on audio tracks, some-
times it is convenient to gather several audio events into an audio part. 
This is simply a “container”, allowing you to move and duplicate several 
audio events as one.

An event and a part.

Each audio track has a corresponding audio channel in the mixer. This 
is much like a channel on a hardware mixer, allowing you to set levels 
and panning, add EQ and effects, etc.
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MIDI terminology

When you are recording MIDI (or entering MIDI data manually in an ed-
itor), MIDI events are created. For example, each note you record is a 
separate MIDI event, and if you record the movement of a modulation 
wheel or other controller, a large number of densely spaced events are 
created.

MIDI events are always placed in MIDI parts. These are “containers”, 
allowing you to move or copy a number of MIDI events (e.g. a recorded 
MIDI melody line) as one item.

MIDI parts are placed on MIDI tracks. For each MIDI track you can 
specify on which MIDI output and MIDI channel its MIDI events should 
be played back. This allows you to have different tracks play back dif-
ferent sounds, in the same or different MIDI instruments.

A MIDI part on a MIDI track. The black lines in the part indicate MIDI events.

Video terminology

• When you import a video file from disk into a Nuendo project, a video clip is 
created that refers to the file.

• A video event is then created, referring to the video clip. Video events can be 
moved, copied and resized without affecting their video clips.

• For a video event to be played back, it has to be placed on the video track. 
There can only be one video track in a Nuendo project.

The video support in Nuendo is described in its own chapter in the 
Operation Manual.
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About this chapter

This chapter contains descriptions of the general methods and proce-
dures used in Nuendo. As this information applies to all parts of the 
program and all ways of working, please take time to read this chapter 
before continuing with the Operation Manual. 

Using menus

Main menus

The menus in the main Nuendo menu bar are available regardless of 
which window is active. You select items from the main menus follow-
ing the standard procedure for the operating system.

However, note the following:

• Menu items that are not relevant in the current window may be greyed 
out.

• It is possible to customize the Nuendo interface so that menu items 
and/or entire menus are hidden.
See page 173.

Pop-up menus

Pop-up menus can be found throughout the program and are often 
used for selecting options or values. A pop-up menu is indicated by a 
small arrow in a field showing the currently selected option/value.

• To bring up the pop-up menu, click the arrow.
Selecting is done as with regular menus.

Selecting from the Snap pop-up menu.
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The Quick menu

In Nuendo, clicking the right mouse button will bring up a contextual 
pop-up menu (under Mac OS X you need to press [Ctrl] and click, or 
preferably use a two-button mouse set up so that the right mouse but-
ton generates a [Ctrl]-click). 
Some areas have special context menus with functions or settings that 
only apply to the corresponding area (for example, right-clicking in a 
ruler brings up a pop-up menu with display format options).

However, right-clicking in the main area of a window brings up the 
Quick menu. As a rule, the Quick menu contains:

• The tools (provided that the window has tools).
See page 202.

• The most relevant menu items from the main Nuendo menus.
Note that if you customize Nuendo so that some menu items are hidden, these will not 
be available on the Quick menu either.

• Settings that are specific for the window.
For example, in the Sample Editor the Quick menu contains settings for which ele-
ments should be displayed in the waveform display.

The Quick menu in the Sample Editor.
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Using tools

Editing in Nuendo is largely done with the various tools. Typical exam-
ples are selecting and moving events with the Arrow (Object Selection) 
tool, drawing with the Pencil tool, deleting with the Eraser tool, etc. 
There are different tools for different windows.

Tools can be selected in three ways:

• By clicking the corresponding tool icon on the toolbar.
When you click a tool icon, the pointer takes on the shape of the corresponding tool.

• By using the Quick menu.
As described on page 201, clicking with the right mouse button in the main area of a 
window brings up the Quick menu. The tools will be listed (along with their correspond-
ing icons) at the top of the menu – to select a tool, simply select it from the menu.

• By using key commands.
By default, the keys [1] - [9] on the alphanumeric part of the keyboard are used, so that 
pressing [1] selects the leftmost tool and so on. You can also use key commands to 
step between the tools on the toolbar. By default, pressing [F9] selects the previous 
tool and pressing [F10] selects the next tool.

The uses and purposes of the tools in the different windows are de-
scribed in the corresponding chapters of the Operation Manual.
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About tool tips

If you position the pointer over a tool icon (or any other icon or button 
in Nuendo), a label will appear after a moment, informing you of the 
function of the icon or button.

• This feature can be turned off by deactivating the option “Show Tips” 
on the General page in the Preferences dialog (found on the File menu 
under Windows and on the Nuendo menu under Mac OS X).

Changing values

Throughout the program you will encounter various value fields that 
can be edited. These can be divided into three categories: position 
values, regular numeric values and names.

Editing position values

Depending on the selected display format (see the Operation Manual), 
position values in Nuendo are usually divided into several “segments” 
(the exception being the “Samples” display format, in which values are 
edited as regular numeric values). Two examples:

If the “Seconds” display format is selected, positions are shown as 
“hours:minutes:seconds.milliseconds”.

If the “Bars+Beats” display format is selected, positions are shown as 
“bars.beats.sixteenth notes.ticks” (with 120 ticks per sixteenth note).

Each value segment can be edited separately, in one of the following 
ways:

• Point at the upper or lower edge of the segment and click.
Clicking at the upper edge will raise the value of the segment one step, clicking at the 
lower edge will lower the value.
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• Point and click directly on the value segment, type a new value and 
press [Return].

• If you are using a wheel mouse, point at the value segment and use 
the wheel to raise or lower its value.
Generally, we recommend that you use a wheel mouse, as this speeds up editing in 
many areas in Nuendo.

You can also edit the whole value (all segments) by double clicking 
and typing in a new value. Note:

• To separate the value segments, you can use spaces, dots, colons or 
any other character that isn’t a number.

• If the “Bars+Beats” display format is selected, and you enter a value 
with less than four segments, the largest position value segments will 
be affected and the program will set the lesser segments to their low-
est values.
For example, if you enter “5.3”, the position will be set to “5.3.1.0”.

• If one of the frame based display formats is selected and you enter a 
value with less than four segments, the smallest position value seg-
ments will be affected and the program will set the larger segments to 
their lowest values.
For example, if you enter “2:5”, the position will be set to “0:0:2:5”.

• If the “Seconds” display format is selected, value editing works as 
with the frame based formats, with one addition: The smallest value 
segment (milliseconds) is considered to be the decimal part of the 
seconds segment.
This means that if you enter “2:50”, the position will be set to “0:0:2:500”, rather than 
“0:0:2:050”.
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Editing regular numeric values

Numeric values other than positions are edited by clicking the value 
and editing numerically from the computer keyboard.

In the Preferences dialog (Editing–Controls page) you can specify 
what should happen when you click on a value field. The “Value Box/
Time Control Mode” item contains the following options:

• In the Inspector and elsewhere in the program you can find value slid-
ers that may be blue or green – click and drag to adjust the value.

Option Description

Text Input on Left-Click In this mode, clicking a value box will open it for editing by 
typing.

Increment/Decrement on 
Left/Right-Click

In this mode you can click with the left or right mouse but-
ton to decrease or increase the value, respectively. To edit 
values by typing in this mode, please double-click.

Increment/Decrement on 
Left-Click and Drag

In this mode, you can click and drag up or down to adjust 
the value (much like dragging a vertical fader). To edit val-
ues by typing in this mode, please double-click.
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• For some values, you can hold down [Alt]/[Option], click on the value 
and keep the mouse button pressed to display a value slider.
This allows you to scroll the value by dragging up or down with the mouse button 
pressed. When you release the mouse button, the value slider is hidden again.

Adjusting the event volume setting on the info line.

• Most values can also be edited using a wheel mouse: point at the 
value and use the wheel to raise or lower it.

Editing names

To edit a name, click on it, type a new name and press [Return] (or 
click outside the name field).
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Using knobs and sliders

In the VST audio windows, most parameters are shown as knobs, slid-
ers and buttons, emulating hardware interfaces. For knobs and sliders, 
you can select the desired way of making adjustments in the Prefer-
ences dialog (Editing–Controls page):

Knobs

The Knob Mode pop-up menu contains the following options:

Sliders

The Slider Mode pop-up menu contains the following options:

Option Description

Circular To move a knob, you click on it and drag in a circular motion, much like 
turning a “real” knob. When you click anywhere along the knob’s edge, 
the setting is immediately changed.

Relative 
Circular

Works like the “Circular” option, but clicking does not automatically 
change the setting. This means you can make adjustments to the current 
setting by clicking anywhere on a knob and dragging, without having to 
click on the exact current position.

Linear To move a knob, you click on it and drag up or down with the mouse but-
ton pressed – as if the knob was a vertical slider.

Option Description

Jump In this mode, clicking anywhere on a slider will make the slider handle in-
stantly move to that position.

Touch In this mode, you have to click on the actual slider handle to adjust the pa-
rameter. This reduces the risk of accidentally moving sliders.

Ramp In this mode, clicking anywhere on a slider (but not on the actual handle) 
and keeping the mouse button pressed, will cause the handle to move 
smoothly to the new position.
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Selecting objects

Selecting Nuendo objects such as audio and MIDI events is generally 
done with the Arrow tool, according to standard selection procedures.

• Clicking on an object selects it (and deselects any previously selected 
objects).

• Holding down [Shift] and clicking on an object selects it without dese-
lecting any other objects.

• You can also create a selection rectangle by clicking in an empty area 
and dragging with the mouse button pressed.
All objects partially or totally enclosed by the rectangle will be selected.

• If an object is already selected, you can use the left and right arrow 
key on the computer keyboard to select the previous or next object, 
respectively.
Holding down [Shift] and using the arrow keys allows you to select the previous/next 
object without deselecting the current object.

❐ There are several additional ways to make selections in the different 
Nuendo windows. These are described in the corresponding Operation 
Manual chapters.
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Zoom and view techniques

Scrolling the view

If the active window isn’t large enough to show all its contents, you can 
scroll the view by using the standard window scroll bars. However, if 
you are using a wheel mouse, there are two additional ways to scroll:

• Rolling the wheel will scroll the view vertically.
If you hold down [Shift] and use the wheel, the view will be scrolled horizontally. Just 
make sure not to point at a value field, as this will edit the value instead.

• If you aim in the main area of a window, click the wheel and keep it 
pressed, the pointer takes on the shape of a hand. You can now scroll 
the view freely by dragging the mouse horizontally and/or vertically.

Zooming

All windows that contain graphical displays can be zoomed horizon-
tally and vertically. While some windows have special zoom functions 
(see the respective chapters in the Operation Manual), a few methods 
are commonly available:

Using the zoom sliders

In the lower right corner of all zoomable displays, you will find two 
zoom sliders.

• To zoom in horizontally, drag the horizontal zoom slider handle to the 
right.

• To zoom in vertically, drag the vertical zoom slider upwards.
There is one exception to this: in the Project window, dragging the vertical zoom slider 
upwards will decrease the height of Tracks (in effect, zooming out). See the chapter 
“The Project Window” in the Operation Manual.
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• Clicking on a zoom slider will move the handle to the click position, in-
stantly changing the magnification.

❐ If the project cursor is visible when you zoom in or out horizontally, the 
magnification will be “centered on the cursor”. In other words: if possi-
ble, the project cursor will remain in the same position on screen.

Using the Magnifying Glass tool

You can use the Magnifying Glass tool to zoom in and out horizontally, 
using the following methods:

• Click once to zoom in one step.
Zooming will be centered on the click position.

• Double click (or press [Alt]/[Option] and click) to zoom out one step.

• Draw a zoom rectangle by pressing the mouse button, dragging the 
pointer and releasing the mouse button.
The view will zoom in horizontally, so that only the area enclosed in the zoom rectangle 
is visible.

Using the Zoom submenu

At the bottom of the Edit menu, you will find a Zoom submenu with 
various zoom functions. Exactly which items on the submenu are avail-
able depends on the currently active window.

• The Zoom submenu is also available as a separate menu item on the 
Quick menu.

• As with any menu item, you can specify key commands for the func-
tions on the Zoom submenu, for quick access.
Key commands are set up in the Key Commands dialog on the File menu, described in 
a separate chapter in the Operation Manual.
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Zooming in the ruler

If the option “Zoom while Locating in Time Scale” is activated in the 
Preferences dialog (Transport page), you can use the rulers for zoom-
ing. This allows you to quickly zoom in or out on a certain position, 
without having to select a special tool:

1. Click in the ruler and keep the mouse button pressed.
The project cursor is automatically moved to the click position. If you don’t want to 
move the cursor, press [Shift] and click in the ruler instead.

2. Drag down to zoom in (horizontally) or drag up to zoom out.
Zooming will be centered on the project cursor.

Zooming in the overview

By clicking the Show Overview button on the toolbar, an extra pane 
appears under the toolbar, the project overview line. 

Show Overview button.

In the overview line, events and parts on all tracks are displayed as 
boxes. You can use the overview line to zoom in or out, and for navi-
gating to other sections of the project. This is done by moving and re-
sizing the track view rectangle in the overview line:

• The track view rectangle indicates the section of the project currently dis-
played in the event display.

• You can zoom in or out vertically by resizing the track view rectangle.
Resizing is done by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other sections of the project.
The number of tracks shown will not change.
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Window handling

Generally, Nuendo windows are handled according to the standard 
procedures. However, the Window menu contains some functions 
that make work quicker and easier:

Menu item Description

Close Closes the currently active window. If this is a Project win-
dow, you will close the current project.

Close All Closes all windows, including all open projects.

Minimize All Minimizes all windows.

Restore All Restores all minimized Nuendo windows.

Tile Horizontally/Vertically 
(Windows version only)

Arranges the open windows next to each other on screen.

Cascade 
(Windows version only)

Arranges the open windows in a partially overlapping pat-
tern.

Window Layouts Allows you to set up different window combinations and 
store these layouts for instant recall. See page 190 and the 
Operation Manual.

Windows… See below.

The open windows list Selecting a window from the list at the bottom of the menu 
brings it to front.
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The Windows dialog

By selecting “Windows…” from the Window menu, you open the 
Windows dialog. This allows you to manage the open windows in 
various ways.

The display to the left lists all open windows, hierarchically arranged 
(so that editors and other windows that belong to a certain project are 
listed under the corresponding Project window). To the right are vari-
ous window functions. To use one of the functions, proceed as follows:

1. Click in the field below the OK button to select one of the selection 
modes: 

Mode Description

Selected Only the windows selected in the list will be affected.

Cascaded The selected windows will be affected, along with all their “under-win-
dows”. Typically, if a Project window is selected in the list, all open win-
dows belonging to that project will be affected.

All All windows will be affected, regardless of the selection.
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2. If you chose the “Selected” or “Cascaded” modes, select the desired 
windows by clicking in the list.
As usual, you can select multiple items by holding [Shift] or [Ctrl]/[Command] and 
clicking. 

3. Use the buttons to the right to activate (bring to front), minimize, re-
store or close the specified window(s).
Closing a window will also remove it from the list.

4. When you are done, click OK to close the dialog.

The Devices panel

If you like, you can manage devices from a central Devices panel:

1. Pull down the Devices menu and select “Show Panel”.
The Devices Panel appears.

2. To display a closed or hidden window, click on its button in the De-
vices panel.

3. Clicking the button again will close the window.
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Undo

There are two ways to undo operations in Nuendo: by using “regular 
Undo” and by using the Offline Process History. 

• The regular Undo can be applied to virtually all actions you perform, in 
multiple levels. 
It is accessed by using the “Undo”, “Redo” and “History” items on the Edit menu, as 
described below.

• The Offline Process History allows you to remove and modify applied 
processing, and is different from the “regular” Undo in that you don’t 
have to undo processing functions in the order they were performed. 
The Offline Process History is described in the chapter “Audio Processing” in the Op-
eration Manual.

The Undo and Redo commands

Nuendo offers wide-ranging, multiple Undo, allowing you to undo vir-
tually any action you perform.

• To undo the last performed action, select Undo from the Edit menu or use the 
corresponding key command (by default [Ctrl]/[Command]-[Z]).
If you select Undo again, the previously performed action will be undone, and so on.

• To redo the last undone action, select Redo from the Edit menu or use the 
corresponding key command (by default [Ctrl]/[Command]-[Shift]-[Z]).
Undone actions will be available for Redo until you perform another action (at which 
point the “Redo stack” is cleared – see below).

❐ You can specify how many levels of Undo should be available with the 
“Maximum Undo” setting on the General page in the Preferences dialog 
on the File menu (Windows) or Nuendo menu (Mac).



NUENDO
16 – 216 Basic Methods

The Edit History window

Selecting “History…” from the Edit menu opens the Edit History win-
dow. This contains a graphic representation of the “Undo stack” (the 
performed actions, with the most recent action at the top of the stack) 
and the “Redo stack” (the undone actions, with the most recently un-
done action at the bottom of the stack). The two stacks are separated 
by a divider line.

The Redo stack.

The Undo stack.

The most recently undone action.

The most recently performed action.
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The Edit History dialog allows you to undo or redo several actions in 
one go, by moving the divider between the Undo stack and the Redo 
stack (in essence, moving actions from the Undo stack to the Redo 
stack, or vice versa):

1. Click on the divider line and drag it up or down.
Drag up to redo actions, drag down to undo them.

In this case, the Delete and Split actions will be undone (and moved to the Redo 
stack).

• You can also click directly between two items in the list, instantly mov-
ing the divider line.

• When you move the divider line by dragging or clicking, the actions 
are immediately undone or redone.
The changes are reflected in all open Nuendo windows.

2. When you’re finished, click OK to close the dialog.

❐ The Undo and Redo stacks are cleared when you close a project.
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About this chapter

Most of the main menus in Nuendo have key command shortcuts for 
certain items on the menus. In addition, there are numerous other 
Nuendo functions that can be performed via key commands. These 
are all factory default settings, but can be customized if you like (see 
the chapter “Key commands” in the Operation Manual for details).

The default key commands

Below, the default key commands are listed according to category.

• As described on page 14, modifier keys are written as:
[Win modifier key]/[Mac modifier key].
For example, “[Ctrl]/[Command]+N” in the list below means “press [Ctrl] under Win-
dows or [Command] under Mac OS X, then press N”.

• Note that it is possible to switch key commands for menu items and 
other functions on and off.
This is done in the Preferences dialog–Configuration page. If you disable a key com-
mand by switching it off, it will not be possible to invoke the corresponding menu item 
or function with the key command. See the Operation Manual chapter “Customizing” 
for more information.
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Audio category

Devices category

Edit category

Option Key command

Adjust Fades to Range [A]

Crossfade [X]

Find Selected in Pool [Ctrl]+[F]

Option Key command

Mixer [F3]

Video [F8]

VST Connections [F4]

VST Instruments [F11]

VST Performance [F12]

Option Key command

Autoscroll [F]

Copy [Ctrl]+[C]

Cut [Ctrl]+[X]

Cut Time [Ctrl]+[Shift]+[X]

Delete [Del] or [Back]

Delete Time [Shift]+[Back]

Duplicate [Ctrl]+[D]

Group [Ctrl]+[G]

Insert Silence [Ctrl]+[Shift]+[E]

Left Selection Side to Cursor [E]

Lock [Ctrl]+[Shift]+[L]

Move Insert Cursor to part start [0]

Move to Cursor [Ctrl]+[L]
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Mute [M]

Mute Events [Shift]+[M]

Mute/Unmute Objects [Alt]+[M]

Open Default Editor [Ctrl]+[E]

Open Score Editor [Ctrl]+[R]

Open/Close Editor [Return]

Paste [Ctrl]+[V]

Paste at Origin [Alt]+[V]

Paste Time [Ctrl]+[Shift]+[V]

Record Enable [R]

Redo [Ctrl]+[Shift]+[Z]

Repeat [Ctrl]+[K]

Right Selection Side to Cursor [D]

Select All [Ctrl]+[A]

Select None [Ctrl]+[Shift]+[A]

Snap On/Off [J]

Solo [S]

Split At Cursor [Alt]+[X]

Split Range [Shift]+[X]

Undo [Ctrl]+[Z]

Ungroup [Ctrl]+[U]

Unlock [Ctrl]+[Shift]+[U]

Unmute Objects [Shift]+[U]

Option Key command
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Editors category

File category

MIDI category

Option Key command

Show/Hide Infoview [Ctrl]+[I]

Show/Hide Inspector [Alt]+[I]

Show/Hide Overview [Alt]+[O]

Option Key command

Close [Ctrl]+[W]

New [Ctrl]+[N]

Open [Ctrl]+[O]

Quit [Ctrl]+[Q]

Save [Ctrl]+[S]

Save As [Ctrl]+[Shift]+[S]

Save New Version [Ctrl]+[Alt]+[S]

Toggle Alternate Key Commands [F5]

Option Key command

Quantize [Q]
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Navigate category

Nudge category

Option Key command

Expand/Undo selection in the Project win-
dow to the bottom 
Move selected event in the Key Editor 
down 1 octave

[Shift]+[Down Arrow]

Expand/Undo selection in the Project 
window/Key Editor to the left

[Shift]+[Left Arrow]

Expand/Undo selection in the Project 
window/Key Editor to the right

[Shift]+[Right Arrow]

Expand/Undo selection in the Project 
window to the top 
Move selected event in the Key Editor up 
one octave

[Shift]+[Up Arrow]

Select next in the Project window (Down)
Move selected event in the Key Editor one 
semitone down

[Down Arrow]

Select next in the Project window/Key 
Editor (Left)

[Left Arrow]

Select next in the Project window/Key 
Editor (Right)

[Right Arrow]

Select next in the Project window (Up)
Move selected event in the Key Editor one 
semitone up

[Up Arrow]

Option Key command

End Left [Alt]+[Shift]+[Left Arrow]

End Right [Alt]+[Shift]+[Right Arrow]

Left [Ctrl]+[Left Arrow]

Right [Ctrl]+[Right Arrow]

Start Left [Alt]+[Left Arrow]

Start Right [Alt]+[Right Arrow]
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Project category

Tool category

Transport category

Option Key command

Open Browser [Ctrl]+[B]

Open Markers [Ctrl]+[M]

Open MasterTrack [Ctrl]+[T]

Open Pool [Ctrl]+[P]

Setup [Shift]+[S]

Option Key command

Delete tool [5]

Draw tool [8]

Glue tool [4]

Mute tool [7]

Next Tool [F10]

Play tool [9]

Previous Tool [F9]

Range tool [2]

Select tool [1]

Split tool [3]

Zoom tool [6]

Option Key command

AutoPunch In [I]

AutoPunch Out [O]

Cycle Pad [/]

Fast Forward [Shift]+Pad [+]

Fast Rewind [Shift]+Pad [-]
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Forward Pad [+]

Input Left Locator [Shift]+[L]

Input Position [Shift]+[P]

Input Right Locator [Shift]+[R]

Input Tempo [Shift]+[T]

Insert Marker [Insert]

Locate Next Event [N]

Locate Next Marker [Shift]+[N]

Locate Previous Event [B]

Locate Previous Marker [Shift]+[B]

Locate Selection [L]

Locators to Selection [P]

Loop Selection [Shift]+[G]

Metronome On [C]

Nudge Down [Ctrl]+Pad [-]

Nudge Up [Ctrl]+Pad [+]

Panel (Transport panel) [F2]

Play Selection Range [Alt]+[Space]

Recall Cycle Marker 1 to 9 [Shift]+Pad [1] to Pad [9]

Record Pad [*]

Retrospective Record [Shift]+Pad [*]

Return to Zero Pad [.] or Pad [,]

Rewind Pad [-]

Set Left Locator [Ctrl]+Pad [1]

Set Marker 1 [Ctrl]+[1]

Set Marker 2 [Ctrl]+[2]

Set Marker 3 to 9 [Ctrl]+Pad [3] to [9] or [Ctrl]+ [3] to [9]

Set Right Locator [Ctrl]+Pad [2]

Start [Enter]

Option Key command
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Window Layout category

Zoom category

StartStop [Space]

Stop Pad [0]

Sync Online [T]

To Left Locator Pad [1]

To Marker 1 [Shift]+[1]

To Marker 2 [Shift]+[2]

To Marker 3 to 9 Pad [3] to [9] or [Shift]+[3] to [9]

To Right Locator Pad [2]

Option Key command

Layout 1 to 9 [Alt]+Pad [1] to [9]

New [Ctrl]+Pad [0]

Organize [W]

Recapture [Alt]+Pad [0]

Option Key command

Zoom Full [Shift]+[F]

Zoom In [H]

Zoom In Tracks [Alt]+[Down Arrow]

Zoom Out [G]

Zoom Out Tracks [Alt]+[Up Arrow] or [Ctrl]+[Up Arrow]

Zoom to Event [Shift]+[E]

Zoom to Selection [Alt]+[S]

Zoom Tracks Exclusive [Z] or [Ctrl]+[Down Arrow]

Option Key command
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A
ACPI 58
Activate Project button 99
Add Bus 120
Add Child Bus 121
Add Multiple Tracks 185
Add Track 74
All MIDI Inputs 52
Alt/Option key 14
Alternative Key Sets 181
Apple Help 13
Arrow tool 134
ASIO 2.0 48
ASIO Device Port 121
ASIO Direct Monitoring 48
ASIO DirectX driver

About 21
Setup 45

ASIO driver
About 20
Installing 22

ASIO Multimedia driver
About 21
Setup 46

Audio
Channels 197
Clips 196
Events 196
Parts 197
Tracks 197

Audio buffer size 57
Audio folder 195
Audio Hardware

Installing (Mac) 33
Installing (Windows) 22
Requirements (Mac) 32
Requirements (Windows) 20

Audio hardware
Connections 38
Setup application 42

Audio inputs 75
Automation 112

C
Channels 197
Child Bus 121
chn setting 90
Clipping indicator 79
Clips

Audio 196
Video 198

Computer Requirements
Mac 31
Windows 19

Connecting
Audio 38
MIDI 49

Copy Protection key
Mac 33
Windows 22

Core Audio drivers 32
Ctrl/Command key 14
Cut 158
Cycle 85

D
Default MIDI input/output 53
Defragmenting

Mac 34
Windows 25

Devices panel 214
DirectX driver 21



NUENDO
Index 231

E
Edit History window 216
Edits folder 195
Effects

Applying 160
Send effects (Audio) 107, 111

EQ 103
Eraser tool 136
Events

Audio 196
Copying 135
Erasing 136
MIDI 198
Moving 134
Muting 136
Resizing 138
Splitting 137

Expert settings 57
Export Audio Mixdown 128

F
Fade-in 139

G
Grid 134

H
Hard Disk

Mac 31
Windows 19

Hard disk
Considerations 56

Help 13
History 216
HTML Help 13

I
Images folder 195
Input busses 75
Input level 41, 78
Input ports 46
Insert effects (Audio) 111
Installation

Mac 34
Windows 25

K
Key command conventions 14
Key commands

Assigning 178
List of default commands 221
Macros 180

Key Editor
Drawing events 165
Moving events 166
Opening 164
Selecting events 166

Knob mode 207

L
Latency 55
Level meters 79
LFE 127
Library 118
Local On/Off 50

M
Mac OS X drivers 32
Macros 180
Magnifying Glass tool 210
Maximum Undo 215
Memory Requirements

Mac 31
Windows 19
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Menus
About 200
Customizing 173

MIDI channel 90
MIDI events 198
MIDI input

Selecting for tracks 89
Setting default 53

MIDI Interface
Installing (Mac) 33
Installing (Windows) 24

MIDI interface
Connecting 49

MIDI output 90
MIDI parts 198
MIDI ports

Default 53
Setting up 52

MIDI recording 92
MIDI Thru 88
MIDI Thru Active 50
MIDI tracks

About 198
Creating 89

Mixer 100
Mixing down to disk 128
Modifier keys 14
Monitor (MIDI tracks) 150
Monitoring

About 48
Setting up 81

Mouse recommendations 31
Multimedia driver 21
Mute 102
Mute tool 136

N
npl files 118
npr files 195

O
Offline Process History 161, 215
Optimizing the Hard Disk

Mac 34
Windows 25

Option/Alt key 14
Output busses 75
Output ports 46

P
Pan

Setting in mixer 101
Surround 123

Parts
Audio 197
MIDI 198

Paste 158
Plug-in automation tracks 154
Plug-ins

Applying 160
Insert effects (Audio) 111
Send effects (Audio) 107

Pop-up menus 200
Position values 203
Preferences

Making settings 173
Presets 176

Presets 176
Process functions 159
Program Change 91
Project

About format 194
Creating new 73

Project folder 195
Project Setup dialog 117
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Q
Quantize 167
Quick menu 201

R
RAM

Mac 31
Windows 19

Range Selection tool 157
Record Enable 80
Recording levels 41
Redo 137, 215
Release ASIO Driver in 

Background 44
Repeat 135
Ruler zooming 211

S
Sample Editor 156
Save as Template 184
Scissors tool 137
Scroll bars 209
Select All 135
Selecting objects 208
Send effects (Audio) 107
Show Panel 214
Show Tips 203
Slider mode 207
Snap

MIDI editors 166
Project window 134

Solo
Mixer 102
Track list 147

Start Record at Left Locator 151
Surround mixing 116
Surround Pan 123
Surround sound setup 40

T
Template 184
Tips 203
Tools 202
Track Parameters 94
Tracks

Audio 197
MIDI 198
Video 198

Transport panel
Customizing 182
Overview 61

Transpose 94
Two-button mouse (Mac) 31

U
Undo 137, 215

V
Value editing 203
Value slider 205
Velocity 169
Video

Clips 198
Events 198
Track 198

Video setup 54
VST Connections

Inputs 75
Outputs 120

VST input ports 46
VST Instruments

Activating 143
Automating 154
Editing 152
Playing in real time 149
Routing tracks to 145

VST Multitrack setup 43
VST output ports 46
VU meters 79
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W
Wheel mouse

Scrolling 209
Value editing 204

Window layouts 190
Window menu 212
Windows dialog 213

Z
Zoom presets 188
Zoom sliders 209
Zoom submenu 210
Zoom while Locating in 

Time Scale 211
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